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This is a comprehensive list of eMule Plus features 
 
* Completely Free: eMule Plus is an open source project and free software, as well as it doesn't contain 
any spyware, adware or the like. 
 
* Improved GUI: the client has been redesigned to have a more intuitive and appealing GUI. Servers, 
Transfers and Statistics windows has been revamped for better screen usage and greater customization. 
 
* Web Server: originally conceived in eMule Plus but now on official this 'light' interface is useful to 
remotely control your client. It's evolving each day, adding features to make it better while not making it 
a resource hog. We have some extended features as Intruder Detection, A4AF support, a graphical queue 
list, client version information, automatic compression support (gzip) and much more. eMule XP and 
eMule Light templates are now included in the main distribution as eye candy or simplified interfaces to 
our Web Server. Templates are optimized to reduce required traffic while keeping compatibility with 
different browsers. 
 
* Better Interface Design: we take special care in the interface design, so you won't see any misplaced 
box or a cut string. Images used in our client and sites are done the best way possible by Graphic 
Designers to be more appealing and meaningful. 
 
* Localization: eMule Plus has its own team of translators localizing new strings. Currently supported 
languages: Basque, Belarusian, Catalan, ChineseSimplified, ChineseTraditional, Croatian, Czech, 
Danish, Dutch, English, Extremaduran, Finnish, French, German, Greek, Hebrew, Italian, Korean, 
Lithuanian, Malay, Norwegian, Polish, Portuguese (Brazil), Portuguese (Portugal), Romanian, Russian, 
Spanish, Turkish, Ukrainian. 
 
* Our Own Team of Betatesters: eMule Plus team has an extensive team of beta testers, including 
Windows 9x users, releasers and a lot of different system configurations are daily tested. We have an 
extensive testing process before a release. This doesn't mean the client won't have bugs, but there will be 
less of them or they won't affect the majority of the users. 
 
* Static Servers Priority: priority for static servers can be changed from the GUI without users having 
to change the configuration files directly. 
 
* Rating/Comments of Files: a better rating information has been added to help users to get an idea of 
the file rating. With several levels of quality and a special icon to inform users about fakes. This system 
accumulates ratings of remote users and calculates an average value shown to you in the thermometer 
style. 
 
* Upload Progress: a different and improved upload progress bar is used to give a better glimpse of the 
status of a client downloading from you. It shows the number of parts each client has as well as currently 
downloading part. 
 
* A4AF (Asked for Another File) Management: the ed2k protocol allows only one file to be 



transferred at the same time from a single client, so other requests to the same user are queued until the 
transferring file is completed. Our client shows you sources that have been requested for other files in 
each single file sources list and allows you to force them to switch to another file. 
 
* Stored Sources: when you close your client for long periods sources are lost. Most of them can be 
recovered with the sources exchange protocol but for rare files the obtained sources from other sessions 
can be lost. Stored Sources allows you to store sources in a file to be retrieved again when you restart 
your client. 
 
* Better Client Information: client software as well as the status is shown with different mule icons. 
Different colors related to the official color of the software are used to give a better insight on the client 
type distribution in your queues and the status of the clients you connect to or those connecting to you. 
Credits, friends and banning statuses are also shown with different icon modifications. 
 
* Unneeded Sources: there are sources in your download queue which sometimes don't have chunks for 
the file you're downloading, so they are using a slot while not being useful for us. This kind of sources 
are removed automatically when the max sources limit for a file is reached. 
 
* Download Queue Progress: queue progress is shown with color coding (progression, regression or 
the same position) and information about how many positions were gained or lost after previous source 
status check. 
 
* Destination Directory: you can set a different (from the main incoming directory) destination 
directory for every downloading file. After completion, a file will be transferred to that directory. 
 
* Filename Cleanup: automatically or manually activated, this feature allows you to clean filenames. 
Unwanted advertisement strings or non-cased files can be formatted in a more pleasant way. 
 
* Improved Search: you can search files not containing strings. There is also support for FileDonkey 
and eMugle web service searches. The selected search method is also retained between sessions, so you 
won't need to change it to your preferred choice every time you start a new search. 
 
* Enhanced Information for Search Results: additional information is available providing the date 
when servers saw a complete source for the specific file last time. This information can be very helpful 
during file selection as it shows the risk of staying with incomplete file. Media information (length, 
bitrate and codec) is provided for media content files in search results. Average file rating (comments 
are unaccessible) collected by servers is available as well together with the estimation of the number of 
voted users. 
 
* Related Files Search: a related search gives the files that are the most published by the clients who 
share the given file. It can be used to detect related (companion) files, but also anomalies in files 
distribution. 
 
* Part Traffic: spreading information in p2p applications is vital. Knowing which files are already well 
spread and which are not is something that releasers request a lot. This information can be obtained from 



the clients currently downloading from you or by storing all transfers information. The Plus team believe 
that the second method is better because you know how your client actively performed. 
 
* Part Status: sometimes, old and not well designed clients asks for parts which are already well spread 
while not asking for rare parts. This isn't useful for the network because files need more time to be 
spread. With this in mind a feature that allows you to disable access to these parts has been bundled in 
the client. 
 
* JumpStart: the initial release of a file is mostly chaotic. The problem is that some parts of the file are 
transferred hundred of times while others are not transferred at all. JumpStart automatically controls a 
release while supervising the spread of the different chunks by hiding well spread parts. This is an 
automated and intelligent process. 
 
* Upload System (zz): the ed2k protocol has been designed in a way only full chunks are shared. As 
chunks have a size of 9Mb you need to complete them before sharing that part to the world. The zz 
Upload System prioritizes the upload of full chunks while maximizing your upload speed with trickle 
slots. These slots use the remaining bandwidth not used by the other downloading clients. The speed of 
spreading parts is prioritized instead of a level transfer speed between all the downloading clients, 
guaranteeing a faster spread of files on the network. 
 
* Small and Rare Files Boost: higher score for rare and small file requests in waiting queue, what 
increases chances to upload rare files as well as faster spread small files. 
 
* Shell Menu: for shared files a shell menu is provided bringing you the file handling options supported 
by the operating system. 
 
* Double-click Behavior: provides a possibility to configure the double-click action for sources and 
files, letting a user decide which way is better. 
 
* Font Configuration: allows customization of the font style and size used within IRC/chat/log 
windows. 
 
* Smooth File Completion: while using a custom made copy routine instead of not quite performing 
system one, completing files now let you with a much more responsive system. 
 
* Message Filtering: allows you to disable messages containing filtered words from being shown. There 
is an option to keep them in the log. 
 
* Comment Filtering: allows you to disable comments containing filtered words from being shown. 
There is an option to keep them in the log. 
 
* Intelligent Chunk Request (ICR): the Intelligent Chunk Request system allows faster file 
downloading by concentrating on the rarest and (or) complete chunks. 
 
* Lancast: saves bandwidth and increases download speeds in dual network capacity environments 



(your PC is on the internet, but also on a LAN with other eMule clients). Your client will discover other 
local/LAN sources and will upload to these clients above your client's normal upload limits, using multi-
cast. Useful for people who share an Internet connection with other eMule Plus users (student networks, 
home networks and Metropolitan Area networks as long as they support multi-cast data). 
 
* Complete Sources: a new column in Shared Files window which shows a range of possible values for 
the number of complete sources, for the files you're currently sharing. If you didn't receive enough data 
to calculate a total range, you will see an approximate value preceded by a sign "<". 
 
* Sources Exchange Disabling: in some old computers source exchange is a resource hog. The feature 
can be disabled in our client and you can also set a limit for it to not be used when files have enough 
sources. 
 
* Banning Configuration: you're mad at aggressive clients or you're soft and don't want to ban 
anybody. We allow a certain degree of customization and even the disabling of the feature. 
 
* Community Sharing: to improve the spreading of files between communities, Plus includes an option 
to set a community priority. This feature doesn't mean you will download only to community users, but 
that they will get a little scoring advantage. 
 
* Multiple Temporary Directories: your temporary disk is filled, but you have enough space at another 
disk. Plus allows you to set more than one temporary directory letting you use free space at other 
partitions. 
 
* Customizable Temporary Directory for Categories: a different temporary directory can be specified 
for a category. After that files will be created in this custom directory when added from start to a new 
category. That means automatically assigned files and files assigned to the particular category during 
download starting after a search (files manually assigned to the category will be created in the main 
temporary directory). Files will not be transferred to a new location if you change the category after file 
creation or select different temporary directory for the category. This directory will also be added to the 
list of temporary directories so on next start eMule Plus will scan all of them and find every single part 
file. This makes it possible to group thematic temporary files as well as use different locations for 
temporary files. 
 
* Download Autopriority Settings: autopriority limits can be customized regarding your downloading 
style. 
 
* Main Process Priority: you can set the client to be run on a higher priority if you use processor 
demanding applications affecting eMule Plus. This way your download/upload speed won't be dropped 
when an application hogs your processor. Note: this high priority has less effect than OS process priority 
configured in Task Manager. 
 
* Hashing Priority: the hashing process is a resource hog task. You can set different priorities for it, but 
take in account that a lower priority will give you a more responsive system while the hashing process 
will last a little longer. 



 
* Scheduler: you use your Plus client in a place where you can't use all the bandwidth at certain times. 
With this feature you can set different time shifts to configure your downloading/uploading speed and 
settings. 
 
* Customizable Sorting: sorting directions and advanced sorting options are available for users to set 
the list sorting they want/like better on every client start. 
 
* Download All ed2k Links in Clipboard: you can transfer a selection of files from a search result to 
the clipboard to be pasted in a TXT file for future use. This is useful as an alternative to having lots of 
files paused. 
 
* Average Data Rate: a new alternative smoothed data rate providing the sustained speed for the 
download. 
 
* Smoothed Remaining Time Calculation: remaining time for a downloading file is more relevant 
now. Downloads which will last for more than 100 days will be shown with a question mark. 
 
* Systray-menu: an improved system tray menu that enables you to set the preferable speed with a 
practical slider, access the preferences and much more. All this while using a better design. 
 
* Countermeasures Against Unfair Clients: some clients on the net are not fair; stealing hashes, 
giving less slots to eMule clients, promoting leecher clients. Those actions can be taken in account and 
penalized by your Plus client. 
 
* Exception Handling: a different way of handling exceptions has been designed to help users help us 
while leaving dumps of crashes which let us know what happened at the time of the problem (not 
always, but mostly). So, now users can actively help us in problem solving. Anyway, crashes have been 
reduced to a minimum and even some exceptions don't crash the system at all. 
 
* L2HAC (lowID to highID Automatic Callback): L2HAC reduces load on servers by reducing lowID 
callbacks. This applies to any eMule Plus with a lowID. lowID eMule Plus clients will connect to remote 
sources just before a highID source would be scheduled to contact us via a server callback. Because we 
have contacted the remote client before a server callback occurs no server is needed to establish a 
connection between two clients. 
 
* Back-Up: you can choose to backup configuration and temporary files used by eMule Plus to be 
sheltered for a crash or a file corruption event. This backup can be done on demand, whenever you close 
your client or periodically. 
 
* eMail Notifier: Information and Warning messages can now be sent by SMTP mail for you to be 
informed of your client status. This feature supports SMTP plain authentication. 
 
* Anti-scanning Measures: if a client requests non-existing file(s) more than 3 times consecutively, 
then the given IP is filtered for 24h. 



 
* Queue Progress Notification: queue progress is shown with color coding (green: progress in the 
queue, red: regression in the queue, blue: same position as before) and information about how much 
positions were gained or lost from the previous source status check. 
 
* Source Filters: you can apply filters to each file in your download list or global filters to remove 
sources you don't want to see when expanding the sources for a file. There is some configuration in 
client preferences. 
 
* Queue Filters: an option to filter the queue by client type (friend and credits) is provided in our client. 
This filter is applied dynamically. 
 
* Keyboard Shortcuts: specific key combinations can be set for common actions (like minimizing the 
client, or switching to another window, etc). A different sort of key combinations can be set for each of 
them. 
 
* File Status Icons: meaningful visual notifications regarding file statuses are now an option for the 
download list. Some actions can be applied to files by clicking on them (i.e. when status paused, 
unpause the file). 
 
* Processor Specific Optimizations: SSE/MMX/AMD optimizations are now automatically selected 
and used for better performance. 
 
* Automated Fake Check: you can see in the search window which files are marked as fakes before 
downloading. The downloading of the database is done by the ed2k network, please keep it shared! 
 
* Improved Client and File Detail Dialogs: better organized, now you can see more information in a 
clearer way. You have the option to scroll the text when it doesn't fit its placeholder. 
 
* Preallocation of Disk Space: an option to allocate all the space needed for a file so you won't have 
insufficient disk space to complete the file or lose downloading sources because of standard allocation. 
This allocation is done in a separate low-priority thread so downloads are not affected as before. Less 
fragmentation is achieved by using this feature. 
 
* Initialize Option: makes possible restarting of the erroneous download without a need of client 
restart. The problem should be solved before executing this option or the erroneous status will be 
triggered again. 
 
* Predefined Status/Media Type Categories: already made categories useful to have filtered views of 
your download list. Also available in the Web interface. 
 
* Improved Logs: each log event has a different color, so errors can be easily distinguished from 
warnings or non-important log events. Log tabs have a visual indication notifying about new entries 
without a need to switch. 
 



* eMule Plus Version Auto-check: with this option you will be informed of new versions when starting 
the client (there is an option to disable this). A debug log entry is added when this option runs. 
 
* MobileMule: MobileMule is a remote control interface for eMule Plus via a mobile phone with java 
support. For more information, please, visit MobileMule homepage. 
 
* IRC: built-in own IRC client to enjoy chat while downloading. Autojoin to English (#emule+) and 
other localized support channels. 
 
* Localized Date/Time: the client uses the user selected OS localization for representing date and time 
entries. This time style is used all over the client. 
 
* Session Timer: a session timer, shown in the status bar, tells you how much time your eMule Plus has 
been running. 
 
* Copy of Logs and Chats To Clipboard or File: by right clicking over the window you will have an 
option to save a log or chat session to a file or copy to the clipboard. Formats supported are plain TXT 
or RTF, and you have the option to select where you want to save the file. 
 
* Hashing Status: a hashing status log line is added for every hashing file, and if you enable debug log 
you will have also a log line before a file starts to be hashed so you can debug your hashing problems. 
There is also a counter in Shared Files window for files waiting to be hashed. During hashing the Reload 
button in Shared Files is disabled to avoid double hashed entries. 
 
* Backup Link for Downloading Files: a copy of the ed2k link needed to redownload a corrupted file 
because of a system crash is stored on .txtsrc file header. This link has also sources to get a quick start. 
 
* Country Flags and Statistics: country flags are shown for remote clients telling you from which 
country a user is. There are additional columns to let you sort by country and specific statistics to let you 
know the percentage of users. This feature can be disabled for low-end computers. 
 
* Improved Tooltips: extended tooltips with icons, colors and a really nice formatting are provided all 
over the client. For servers, downloads, sources, status bar, categories. All of them include extended 
information that can be viewed after placing a cursor over an object for a predefined amount of time. 
 
* Auto Max. Sources and Limit for Overall Sources: you can set a progressive limit for sources as 
well as a maximum number of sources to be added to your files. With this feature enabled you can have 
a smoother client start as well as a better client running by controlling the amount of sources found and 
used at any time in an automatically way. 
 
* Antivirus: if you don't use a live monitoring antivirus on your PC, because of the resources that kind 
of tool takes, now you can schedule checks of the files which were completed or call it directly from 
Plus. This option is configurable with extra parameters and can be set to run automatically or be 
triggered by a download context menu option. 
 

http://mobil.emule-project.net/


* Corruption Handling: downloaded data is checked for corruption and only valid data will be shared. 
Corrupted data block is redownloaded automatically. A special algorithm, ICH (Intelligent Corruption 
Handling), is used to reduce an amount of redownloaded data, what saves in average about 50% of the 
redownloading data traffic. 
 
* Improved Compressed Streams Handling: eMule Plus has improved the handling of compressed 
streams to avoid data corruption and minimize an amount of redownloaded data. The old feature "Drop 
Super-Compressed Blocks" was phased out because there is no need to have it manually set now as that 
is handled automatically. 
 
* Serverlist Visual Indication: failed servers, connected server and static ones are now indicated with 
graphical icons for a quick overview and more intuitive server list style. 
 
* Autoupdate IPFilter: you can update IPFilter from an external service avoiding the need to reload the 
client and to keep the filters updated with a central database. The update can be set to be made 
periodically on client start. After a successful update you can't update it again in next 24 hours not to 
exhaust list providers bandwidth. 
 
* Downloading Chunk Time and Size Information: additional information is shown for every 
downloading such as currently downloading chunk, amount of data required to complete a chunk as well 
as estimated time of chunk completion by the particular source. 
 
* Fractional Upload/Download Limits: upload and download speed limits can be specified with 0.1 
KB/s granularity (minimal speed limit is 1 KB/s). That gives possibility to set speed limits more 
precisely, thus it helps slightly increase speed limits especially for low-speed connections. 
 
* Comprehensive Chunk Information: extensive information about downloading file chunks is 
available providing comprehensive data about every part including amount of received data, part status, 
number of available sources, as well as graphical presentation for better review. 
 
* Command-line Interface (cli): several basic commands are available to control eMule Plus operation 
from command-line or batch scripts. More details in "FAQ->Tips - useful not visible features". 
 
* Shared File Permission: permission to show a file in the shared files list which can be requested by a 
remote user. This feature provides comprehensive flexibility to report only desirable shared files for 
particular user category. 
 
* Auto Download Lists: every X minutes client downloads Xml files from preconfigured locations, 
which contain ed2k links, those links are automatically added to download into specified categories. 
Useful for first spreading of files inside groups, etc. 
 
* Improved Source Exchange: tracks all file requests (not only clients waiting for some file in waiting 
queue) what provides more sources for source exchange requests as some clients can request several 
files. 
 



* Large File Support: eMule protocol extension to support large files (> 4GB). Maximum supported 
file size is 512 GB - 1 byte (549,755,813,887 bytes). 



Does eMule Plus contain spyware or adware? 
No. eMule Plus is open source and has no business model. It's free and will always remain free. 
 
How can I patch my Windows XP SP2 TCPIP.SYS to allow more half open connections? 
You should download the last xp-AntiSpy that has a feature to patch the library to allow more 
connections. Before SP2 there was no limit for such connections, but it might be better instead of 
removing the limit to use a big number like 4096. 
Beware that regular updates can and will revert this change so it's wise to check every once in a while 
that the limit wasn't reverted back. It could be that after an update you will need a new version of xp-
AntiSpy. Please check their site when you have problems patching TCPIP.SYS. 
 
What is eMule's download ratio? eDonkey 2000 was 1:4, but eMule? 
1:3 for less than 4KB/s upload limit. 
1:4 for less than 10KB/s and more than 4KB/s upload limit. 
Unlimited for more than 10KB/s. 
 
If I'm connected to a certain server and I double-click on another server, do I stay connected to 
the old server and the new one also? 
You will first be disconnected from a server before trying another connection attempt. If you try to 
connect to the currently connected server you will receive a message and the operation will be cancelled. 
 
I have a LowID, what does it mean? 
A LowID means that other clients can't connect directly to yours, but through the server. Connections 
between two LowID clients aren't possible and LowID clients have less possibilities of connecting to 
popular servers because they have a limited number of slots for this type of connections. Anyway 
LowID clients can transfer both sides by communicating with other clients through the server. 
Firewalled or proxied clients are mostly LowID ones. Sometimes you can receive a LowID because the 
server was busy to process and check your connection request (disconnecting and reconnecting after a 
couple of minutes should solve this problem). 
 
Why do I have LowID after upgrading to the new version? I used to have HighID before... 
Your firewall has detected the change and is treating the new version as a completely different 
application. To fix this issue, open your firewall's configuration and delete the access rule for the 
previous version of emule.exe. If you know how to, create the rule for the new version, allowing it 
unrestricted access. Or just start the new version and when the firewall asks you whether or not emule.
exe should be allowed to connect to the internet, answer 'Yes' and 'Always use this action'. 
 
Clicking links on ed2k link sites doesn't work. It just pops up a window saying its not associated 
with any program or gives an error, what can I do? 
Click the "ed2k Links" button in the General tab from Preferences. 
If it still doesn't work try the following: 
1. Click Start -> Run 
2. Type regedit 
3. Find the pathway "HKEY_CLASSES_ROOT\ed2k" 

http://www.xp-antispy.org/


4. Delete this key 
5. Open preferences (button should be enabled again) and click it 
If you don't have Internet Explorer (or any IE based browser like MyIE2) additional steps are needed... 
 
"For Opera Browsers"

If you attempt to open an address using a protocol which is not 
recognized or supported by Opera, you will see the following 
error message: "The address type is unknown or unsupported". Even 
though Opera cannot handle this protocol itself, it is possible 
to tell Opera to pass the URL on to the program which is set to 
be the default application for this protocol in Windows. 
In Opera 7.5, go to "Tools -> Preferences -> Programs and 
paths" (in Opera 7.2x, "File -> Preferences -> Programs and 
paths") and click the "Add" button under "Protocols". This will 
open a dialog box called "Protocols". Now, simply enter the 
protocol in the "Protocol" field without a colon or slashes (for 
example, you can enter "ed2k", but not "ed2k:" or "ed2k://"), and 
either set Opera to use the system default application to handle 
this protocol, or specify one in the "Open with other 
application" field.

 
 
"For Mozilla 1.7/Firefox 0.9 and above"

NOTE: Mozex doesn't work anymore with these new versions. There 
is an alternate method that works with both of them: 
1. Remove Mozex (if it was already installed)  
2. Write "about:config" in the browser address bar and hit enter 
3. A configuration list will be shown. Right click on the list, 
select "New", then "Boolean"; write "network.protocol-handler.
external.ed2k" as Preference Name and "true" as Value. 
4. Again, right click, select "New" and "String"; write "network.
protocol-handler.app.ed2k" as Preference Name and "C:\Program 
Files\Mozilla Firefox\firefox.exe" (or the path where the program 
is installed in your system) as Value.

 



 
"For Mozilla 1.6/Firefox 0.8 and below"

Go to Mozex and install the last plugin release. Restart Mozilla 

and go to Edit -> Preferences -> Mozex -> ED2K and set it to "C:
\Program Files\Mozilla\mozilla.exe %r" (or the path where the 
program is installed in your system). In Firefox 0.8 you will 
have to go to "Edit -> Preferences -> Extensions -> Mozex -> 
Options -> ED2K".

 
What is Community Sharing? 
Users whose usernames contain the string you defined in the Community Sharing settings are given 
slightly higher priorities in the upload queue. Do not enable this unless you know what you're doing. 
 
How can I create a Community? 
You must tell users in your community to add to their nick a tag (it has to be the first tag of all). This tag 
is the name of the community between brackets ( i.e.: [COMMUNITY] ). Then they should enable the 
feature Community Sharing and add that tag WITHOUT the brackets to it ( i.e.: COMMUNITY ). This 
way you will give a 1.5x increase in the queue score for users using the tag. 
 
What are the upload file priority modifiers? 
File priority is one of the base values used to build the score for every user in your queue. File priority 
modifiers: Release (for a complete file) 10x, Release (for a downloading file) 5x, High 2x, Normal 1x, 
Low 0.5x, Very Low 0.2x. 
 
What is the "Max Connections In 5 Sec" setting? 
That setting determines the maximum number of concurrent connections eMule Plus is allowed to make 
in 5 seconds. The default setting is 100. Increase it only if you have a fast computer/connection and have 
no problems with routers, etc. You may want to decrease it (to 20, for example) if you see signs of 
eMule Plus creating too many connections, like when you have problems surfing the net while eMule 
Plus is running. 
 
Does eMule Plus always download the rarest chunk? 
Yes. It makes use of Vorlost's and eklmn rarest-chunk algorithm (aka as ICR, Intelligent Chunk 
Recognition) which is an improvement over the one implemented in official eMule builds. Anyway we 
can't avoid downloading most spread chunks first as they are much more available than the others. 
 
Under the priority column some QR: 123 legends appears, what's that? / Why I have red, green or 
blue values in the priority column? 
QR: Queue Rating. The position in the source's queue you have, that means how many other users are 
before you in the remote user's queue. Queue progress is also shown with color coding (green: progress 

http://mozex.mozdev.org/index.html


in the queue, red: regression in the queue, blue: same position as before) and information about how 
much positions were gained or lost after a source status check. 
 
What do these numbers mean in the Sources column of the download list? 
Sometimes there are three values displayed in the Sources column (e.g. 420/500 (3)). They are the 
number of sources with useful chunks, the total number of sources available and the number of sources 
transferring data to you at this moment. There can be an additional value displayed (400/500+24 (3)) 
representing a number of A4AF sources (if you have 'Show A4AF filename on each source' enabled in 
Preferences->General->Window (Lists)). 
 
What do those numbers mean in the Parts column in upload window? 
The parts column shows a value like '3/5 (0)' meaning, first the number of chunks a remote client has, 
second the total number of file chunks and in brackets the chunk that is requesting from you. Numbering 
starts from zero, so you have chunk0, chunk1 ... chunk4 for this example. 
 
Do the priority settings affect your download speeds? 
Download priority helps you prioritize the sources search, the start of a paused file or the allocation of 
more bandwidth. You won't get directly more speed because of a high priority but more sources and free 
bandwidth (that could end in a visible gain of speed). 
 
I got a crash, then a dump. Now what? 
The dump files will be used by developers to investigate where the problem was at the time of the crash 
(not all dumps will be useful). Files must be sent to eMulePlus@yahoo.com.sg after compressing them 
in ZIP/RAR format. Tell us which version you were using in the subject/body of the email. Please do not 
send other MODs dump files. 
 
Some Sources are in grey in the download list. What does it mean? 
When a source has been requested for another file as well (A4AF), the source is marked with gray. The 
other requested filename can be shown by setting this option in preferences. 
 
Some Files are in grey in the download list. What does it mean? 
When a file is paused or stopped it is highlighted with gray. You can enable/disable this behavior in 
"Preferences->Window (Lists)->Show paused files in gray". 
 
What do these rate and score columns mean in the waiting queue? 
When a client enters your queue he is assigned with a starting value of 100. This value is modified by 
some factors (file priority, friendship, credits earned, rare file ratio, small file ratio) and determines the 
priority the client has to start downloading when an upload slot (or trickle slot) becomes available. 
Higher values are the ones that will enter your upload queue first. The score column is calculated with 
the same modifiers used by the rating, but being based on the time the client was waiting in your queue. 
 
Why do I have an upload slot with a huge speeds and the rest with near to 0 speeds? 
Since version 1a eMule Plus is using zz's upload system with Full and Trickle upload slots. The goal of 
this system is to: 



- Only keep as many upload slots open as necessary to fill upload bandwidth. All these open slots are 
given as much bandwidth as they can handle.  
- Keep a few trickle uploads open, ready to go, if one or more of the active uploads quits or times out. 
These trickle uploads can immediately be activated to use the free bandwidth.  
- A fully active upload slot can be downgraded to a trickle upload if the slots above it wants more 
bandwidth. The uploads slots are prioritized so that the longer the upload time the higher its priority. A 
slot with higher priority will get the bandwidth from a slot with lower priority, if it can use it. If a slot 
suddenly demands a lot of bandwidth many of the other slots can be downgraded to trickle uploads. So 
there can be more than a few trickle uploads open at the same time. As soon as some of the transfers 
completes the total number of slots will decrease. 
 
What is the 'Download from all A4AF sources' command for in the right-click menu over a 
downloading file? 
The edonkey protocol allows only 1 transfer per client. When you download 2 files, file A and file B, 
and there is one user who has both files, you can only download one file at a time. The other file shows 
A4AF (Asked For Another File) on this particular source (user). If you want to download from all 
sources (take over all sources), you can choose 'download from all A4AF sources' on file A. File B will 
lose all the shared sources (A4AF sources will appear instead). If you choose 'download from all A4AF 
sources (Auto)', all future A4AF will be taken over too, but this can be made for only one file. 
 
I'm not uploading to anyone after a new installation, what is happening? 
You must share at least one full file because recently started downloads won't be shared until you have 
at least a full chunk. Sharing a complete file is always a good idea. Also, if you use a software firewall 
that needs applications to be certified before traffic is allowed you should add eMule Plus executable 
again, and sometimes even after changing versions. 
 
Why even with the zz's upload system some users don't transfer a full chunk from me? 
There could be different reasons. Like for example that another client is set too close to its physical 
upload limit, that there was a genuine network glitch between you and him, or, for example, that you 
were put on upload when the other clients were unable to accept all the allocated bandwidth for some 
time, but then they got better and your slot isn't needed - so you're put back on queue - but at the top of 
it, so that you're basically next in line again, only you've gained some kilobytes. 
 
Which player is better for previewing? 
Windows Media Player is not intended for PART previewing, as well as most media players. We 
recommend you use Gabest Media Player Classic (http://gabest.org/) or VideoLAN Client (http://www.
videolan.org/) instead. If you don't want to use them you should enable 'Create backup to preview' in 
preferences, and be warned that not always the files will play. If you use one of them (part enabled 
players) you can enable the option "Player supports small blocks". Beware that not all players support 
this feature. 
 
When I look inside the temporary folder it shows that the .part file that I'm downloading is 
680MB so it seems that it is downloaded completely, but inside eMule Plus it shows that I have 
50MB and it is still downloading. What does this mean, is the file downloaded or not? 

http://gabest.org/
http://www.videolan.org/
http://www.videolan.org/


The full size of the file is used for the .part file when you download the last chunk. If you used 
Preallocation feature you will have also this outcome. If your system uses NTFS, you can compress your 
temporary folder so it will minimize this space hogging but while the download advances you will 
eventually need the space. 
 
Save/Load Sources, How does it work? 
With this feature you can store sources that can't be contacted at the moment of adding them to the 
queue or to keep them when the client is closed for later usage. During a client restart stored sources are 
contacted up to 2 more times until they are discarded. Sources are kept up to two days, that meaning that 
if you close your client for more than two days your stored sources will be discarded when you start 
your client. This is to prevent asking sources which will have different IP. Sources are always saved but 
take in account the expiration days. 
 
I'm having double entries for each shared file, where is the problem? 
If you have Incoming directory listed in the shareddir.dat file (when it isn't needed), this behaviour 
should be expected. Remove Incoming entry from that file to solve the problem. 
 
How can I add files to categories? 
As simply as dragging selected files and dropping them into the desired category tab (a category can be 
created using context menu All->Add category). There is also a file context menu option. Besides that 
files can be added to the categories by means of auto assignment category feature when user-defined 
patterns are used to assign files to the appropriate categories. 
 
How can I compile the source code? 
Building from CVS 
 
Why after I add a file sources are not available for some minutes? 
With new server policies, clients should be conservative while asking for sources. Because of that now 
sources are quantified and source requests are done every 5 minutes so you won't be banned. 
 
Why doesn't Initialize fix an erroneous file? 
Files get the erroneous state because of a problem (i.e. disk space), and so this problem should be fixed 
before using this feature. If not, the file will be set to erroneous again. It could happen that even after the 
problem is solved the Initialize feature doesn't work. You will have to restart client in this cases. 
 
I want to clean my search history, how can I? 
In order to completely clear the search history, simply press 'Ctrl + Del' while in search name edit box. 
You can also delete the AC_SearchStrings.dat file in eMule Plus Config folder while the client is not 
running. 
 
How can I sort sources while they are expanded instead of files? 
Use the Ctrl key over the download list while clicking column headers to sort sources. 
 
My Firewall reports outgoing connections on port 25 (smtp), why? 
Nothing to worry. There is obviously another client that runs his ed2k client on port 25, usually because 

http://emuleplus.info/forum/index.php?showforum=23&hyperlink=/Developers/KB/Building


of restrictions from his ISP as mail ports are seldom throttled. You can set your eMule to any port you 
like. It's not a law that port 25 is always SMTP, it's only usual behaviour. So you will see other known 
applications ports being used like IMAP, PPTP, FTP. This is because your firewall software doesn't 
inspect the packet, but just the destination port (not useful).  
 
What do the file name colors in the Search window mean? 
This indicates the number of sources available for the file. The bluer the text, the more servers have 
sources available (up to about 13 - after that the text doesn't get any bluer) The blue is mixed with 
whatever you've chosen for your window text color (usually black). So black = no sources and blue = 13
+ servers with sources. The same is true for files you are already downloading, but red is used instead of 
blue (dark red may look brown on your machine). Green indicates that you have already downloaded the 
file and Orange that the file was downloaded before, but currently not being shared. 
 
What is the meaning of Last Seen Complete column in the Search list? 
Servers can report when they saw a complete source last time. This information can be very helpful 
during file selection as it shows the risk of staying with incomplete file. 
The meaning is the following: 
- no information means that a complete source is available right now 
- date shows exact date when servers saw complete source last time 
- 'never' means servers have never seen a complete source 
 
How can I search for a file on servers using file hash? 
Enter ed2k::<hash>, ed2k:<size>:<hash> or a complete ed2k link into Name edit box on the search 
page and press Start. 
 
What is Related Files Search? 
A related search gives the files that are the most published by the clients who share the given file. It can 
be used to detect related (companion) files, but also anomalies in files distribution. 
This feature helps to find companion files -- let's assume that you have one file from some set of files, 
related files search may help to find other files from the corresponding set. 
To perform related searches: 
1) Type related::<hash> or related:<size>:<hash> in Name edit box and start a search (other search 
fields can be also used to reduce the number of results); 
2) Right-click a file in the search list and select Find related files (it will start search using related::
<hash> criterion -- other search fields are not used). 
Note 1: the feature is available starting from server version 17.5. 
Note 2: the feature works only for server type search (on the server client is connected to). 
 
How can I search for multiple file extensions? 
Enter multiple extensions separated by commas into Extension edit box on the search page, for example, 
zip,rar,cbz,cbr. To do an exclusive search by multiple file extensions use ! operator, for example, !
wme,!wma. 
 
Why did I get blacklisted by a server? 



Depending on how you look at things being blacklisted is a good thing and a bad thing. Why it's bad... it 
limits the number of downloads (but not much though). Why it's good?... it stops excessive strain placed 
onto the servers, which is better for everyone. If you happen to be blacklisted don't worry, its only 
temporary so as long as you don't do it again you won't get blacklisted again. Check the server log to 
find out whether you have been blacklisted or not. 
You got blacklisted because of: 
- To many simultaneous downloads: more than 20/30 downloading files depending on the server. 
- Too many shared files: you should look into the soft/hard server file limits on serverlist to know the 
allowed number of shared files. 
- Jumping to multiple servers in a short time: the UDP search feature will find the sources for you 
without the need to do this, just be patient. 
- Searching: try using an ed2k indexing site for the files you're looking for. Alternatively search through 
one of the sites in the drop list (Filedonkey). 
- Stopping and resuming your files multiple times: this will only spend credits from your server 
connection and won't bring more sources. 
More information about blacklisting can be found in Common Topics. 
 
Is there any way to disable sharing? 
We don't know your circumstances, but there will be no way in eMule Plus to disable sharing. Feature 
request for this will be automatically denied. The ed2k network was built over one of its features that is 
forced sharing. We believe is one of the factors that made the network a success. 
 
What server is the best for my files? 
In short it doesn't matter. UDP search feature will bring sources from other servers after some time 
without needing to be connected to all of them. And also with source exchange available you won't need 
much servers after the first sources are received. 
 
I got a message saying I'm leeching, that I don't understand p2p or sharing or that I was banned. 
What does it mean? 
Unless you are using a leeching mod client, it's just a mistake, and you can safely ignore it. Most 
leeching clients steal userhashes like yours so they can make use of your credits, and certain mods will 
confuse your client sometimes as the mod doing the stealing. There's not much you can do, just ignore it 
or filter out any future messages in preferences. 
 
I'm a new user and when starting eMule Plus it slows down my computer for a long time, what's 
up? 
If you are sharing a lot of files, it's probably that eMule Plus is hashing them (generating a unique ID for 
each one) which can take a while depending on the number of files, size of them, and your computer 
speed. If it's still slow after an hour or so, then report it, but it is quite normal for it to be slow for a while 
on the first start. Try reducing hash priority to idle or even low to get a more responsive computer. 
 
In my log an event says a part was corrupted. Does this mean I have to delete it and try again? 
No, just let eMule Plus do the work for you. It will just re-download the part that is corrupt again the 
needed number of times until it's ok. 



 
Transferred amount is more than the filesize, why? 
The transferred amount is the amount of data received for that file. This includes corrupted data and non-
requested data, sent by remote clients, which have been discarded. The completed column represents the 
usable data including non-corrupted parts and the gained because of compression. 
 
Can I view my credits? 
Since credits are not global but varies depending on each client you uploaded to, it is not possible (we're 
pretty confident there is no 'easy on the network' way of making it possible in the future either, so please 
no feature requests). Remember, your credits do not get stored on your computer, so don't think clients.
met file is your credit file, because it isn't.  
 
How do I build credits? 
Share. That's the only way you can build credits. The more you transfer to a client the more credits you 
will have from it. To build credits to a more diverse range of users, share a more diverse range of files. 
 
Clients got deleted (not seen within 5 month), why? 
This are not your credits being lost. Just old clients you haven't downloaded from for the last 5 months. 
They get purged from the clients.met file to keep the size down. 
 
I want to reinstall eMule Plus again but don't want to lose credits built up. How can I save my 
credits? 
Your credits are identified by other clients because of the information stored in the userhash.dat, 
preferences.dat and cryptkey.dat files. Retain these and copy them over to the new installation before 
starting the client and you will keep all credits you have gained. It's also nice to keep credits you gave to 
other users by retaining the clients.met file. 
 
What is the most effective method to update keeping all my settings and credits? 
- make a copy of the previous eMule Plus configuration directory (just for sake) 
- download eMulePlus-xx.Binary.zip 
- unpack it 
- copy all unpacked files to the directory eMule Plus was installed before 
- that's it 
Note 1: do not copy config\ipfilter.dat if you use your own ipfilter.dat. 
Note 2: do not copy config\staticservers.dat if you use your own static servers list. 
 
After logging into the Web Server, preferences works, but the other links keep asking me to open 
or save it as a download. What can I do to get it working? 
Either disable the gzip compression in the preferences or set in IE (Tools -> Internet Options -> 
Advanced) the "use HTTP 1.1 through proxy connection" to enable. 
 
My upload speed is exceeding my upload limit, why? 
- Check to make sure you have entered the correct limit value for uploads in settings. This might have 
been changed by you sometime and forgot to return it back to the old value. Values in the capability 



field have no effect on connection speeds, they are only used for statistical graph purposes. 
- Disable Lancast (the main cause). You only need this if you are on a LAN. 
- If not any of the above, and the speed is only 1-2KB higher then you might have a huge overhead 
being made. This can happen and shouldn't be reported. 
- If none of the above, then its likely you have found a bug. Please report it with as much detail as 
possible. 
 
Where is the remove unneeded sources option? 
Ironically, it has been removed since it's no longer needed nor good for the network or your client. 
Please do not ask for it to be placed back as it will not be. 
 
Where is the drop super-compressed blocks option? 
It has been removed since it's no longer needed and it's done automatically. 
 
What does each color of the progress bar mean? 
 
Download Progress 

 
 

 
 
Red: no source is available for this chunk/file 
Black: this part is already downloaded (file bar), or can be downloaded from the source 
Green: the file is complete (file bar), or both the source and you already have this chunk 
Purple: the source doesn't have this chunk, but can get it from you 
Blue: less (light-blue) or more (dark-blue) source for this chunk/file 
Lemon (light-yellow): a requesting chunk 
Yellow: a chunk currently being transferred 
Dark-yellow: already transferred part of the transferring chunk 
Grey: neither source nor you have this chunk 
 
NOTE: there is a bar in the top of the progress bar telling you the percentage completed of a file. The 
green part is the percentage of complete verified chunks and the yellow part is amount of received, but 
not yet verified data. There is also a number (optional) telling you the percent of completion in numbers. 
 
Upload Progress 



 
 
Black: the source has this chunk, but you don't 
Green: both the source and you already have this chunk 
Purple: the source doesn't have this chunk, but can get it from you 
Grey: neither source nor you have this chunk 
Yellow: the client is currently transferring this chunk 
Dark-yellow: already transferred part of the transferring chunk 
 
Parts Histograms (File Details->Parts) 
Parts Availability 
Red: no source is available for that chunk 
Blue: light-blue to dark-blue represents the number of sources having that chunk 
 
Parts Completion 
Black: no data received for that chunk 
Blue: light-blue to dark-blue represents percentage of chunk completion 
Green: the chunk is complete 
 
Part Traffic 
 
Standard color 3 row style 

 
 
TrafficGram 

 
 



Alternate color 3 row style 

 
 
The data collected by this feature is stored in the traffic.dat file in the Config eMule Plus directory and 
in temporary archives for each downloading file (with the .stats extension). You can set the color coding 
and the type of data shown in preferences (Part Traffic section). This feature can be disabled in 
preferences to reduce resource usage. 
 
Double clicking a file will bring the detailed statistics for each chunk of the file (the chunk number is at 
the left) as well as the status of each chunk ("*" is shown for each completed chunk). 
 
Uploads column 
Value format is "X (Y)", where X is Complete Uploads -- count of "complete" file uploads, that means 
only if every chunk of the file was uploaded 1x you get a count of 1x. For example, if all except one 
chunk were uploaded 3x and the one only 1.5x, you get a complete upload of something between >=1.5x 
and <2.0x, depending on the number of chunks, and Y is Uploads -- the result of 'total-transfer / filesize'. 
 
"Part Traffic" column with a selectable coloring 
The default mode means (all rainbow colors are used to get a high resolution for the traffic):  
0x .. 1x black to red  
1x .. 3x red to yellow  
3x .. 6x yellow to green  
6x .. 10x green to cyan  
10x .. 15x cyan to blue  
15x .. 21x blue to pink  
21x .. pink to white  
 
You also can merge statistics data when a file changed its name. 
 
NOTE: for more info visit xrmb's homepage 
 
 
Auto Download Lists 
All configuration is placed in Preferences -> Advanced -> Auto Download. 
After you enable it and configure URL(s) and check interval, eMule Plus will download the specified 
file every <interval> minutes. Downloaded file is expected to be in this Xml format:

<autodl min_interval="1440"> 

http://xrmb.home.comcast.net/emule/all.html


<item link="ed2k://|file|File1.avi|123|
786AFC89F4748C83DF3488D246C337E7|/" category="Movies" /> 
<item link="ed2k://|file|File2.avi|456|
886AFC89F4748C83DF3488D246C337E7|/" category="Animation" /> 
</autodl>

 
That means, minimum check interval for this file should be 1440 minutes, and it is changed to this 
automatically, if lower. Files 'File1.avi' and 'File2.avi' are automatically added to download, if they are 
not downloaded / downloading yet. If you have configured 'Movies' and 'Animation' categories, they are 
added into these categories, if not, they are added as uncategorized. In next version is planned to add 
mapping between real and downloaded Xml's categories. 



Servers Window Context Menu 
 
Connect to selected Server 
Connect to the server that is currently selected. 
 
Priority 
Set a priority for the server. This will be used when the option 'Use priority system' in preferences is set 
to connect to server with higher priorities first. 
 
Add to static serverlist 
Add the currently selected server to the static list to be fixed in each session you start. You can set an 
option to connect to this kind of servers only. 
 
Edit 
Edit server settings. To edit static servers settings remove it from static server list, edit and add it to the 
static server list again. 
 
Remove from static serverlist 
Remove the selected server from the static server list. 
 
Remove selected Server 
Remove server from server list. 
 
Copy ed2k link to clipboard 
Copy an ed2k server type link to the clipboard. 
 
 

Transfer Window Context Menu 
 
Downloads 
 
Clear Completed 
Clears selected complete files (green progress bar). 
 
Tip 1: right-click on the Download header to clear all completed files. 
Tip 2: click on the status icon of the complete file clears only this file. 
 
Clear All completed downloads (context menu on the empty space) 
Clears all complete files from the list. 
 
Assign to category 
You can set a category for a group of files with this option. 
 
Priority 
Set a search source priority for the selected files. 



 
Cancel 
Cancels the selected files. This will delete them from the download list. This can't be undone so be 
careful. 
 
Stop 
Stops the selected file. All found sources will be lost and after restart the client will have to find them 
again. 
 
Pause 
Pauses the selected file. All found sources will be retained and contacted after resume. 
 
Resume 
Resume a stopped or paused file. The downloading will be resumed. 
 
Initialize 
Enables a user to restart an erroneous download. The problem should be solved prior to execute the 
command or the erroneous state will return. This option only appears for erroneous files. 
 
Open file 
Open a file when it is completed. The default association for that file will be used for the opening. 
 
Open containing folder 
Opens the folder containing the current complete file. 
 
Preview 
Preview a media file. The file should have the chunks required for file preview already downloaded. 
 
Show File Details 
A complete list of file details is shown and also a feature to change the file name and view file names 
used by the others. 
 
Show all comments 
File comments added by other users can be reviewed with this option. 
 
Source Filtering 
With this feature you can filter source types for each file on your download list. To set filters globally 
you must click in an empty space (normally at the end of the list). 
 
Advanced 
Menu for advanced features. See 'Advanced' group below. 
 
ed2k Links 
Copy ed2k hashes or links to the clipboard in different formats (standard, HTML and with sources) 
 



Web Services 
A list of Web Services that can be customized by changing the file webservices.dat. You can use an 
special separation TAG to group options inside that file (<separator>). When used a line will be added in 
the selected position. 
 
Advanced (Transfer Window sub-menu) 
 
Cleanup filename 
Clean a file name using the current cleanup strategy and the customization you made in the preferences 
window. 
 
Change destination directory 
You can alter the destination for a particular file. The file will be moved to this directory after 
completion. Beware that this directory will be automatically added to the shared directories list. 
 
Preallocate disk space 
You can allocate all the space needed for a file so you won't have insufficient disk space to complete the 
file or lose downloading sources because of initial allocation. This allocation is done in a separate low-
priority thread so your downloads are not affected as before. 
 
Scan for viruses 
If you configured Antivirus support in the preferences, you will be able to launch specified software to 
scan selected files for viruses (only complete files are scanned). 
 
Get first/last chunk for preview 
Media files can be previewed before fully downloaded. This option forces a higher downloading priority 
for chunks required to make a preview possible with programs supporting part previewing (e.g. 
VideoLAN client, Media Player Classic, etc.). 
 
Download from all A4AF sources 
Force all 'Asked for Another file' sources to switch to this file. This means more sources will be queued 
for this file. 
 
Download from all A4AF sources (same category) 
Force 'Asked for Another file' sources of the same category to switch to this file. This means more 
sources will be queued for this file. 
 
Download from all A4AF sources (auto) 
Automatically take all 'Asked for Another file' sources so a file can be completed faster. 
 
Swap all A4AF sources to other files 
Force no needed parts sources to switch to other files. This means more sources will be available for 
other files. 
 
Uploads 



 
Show Details 
Show client details. 
 
Add friend / Remove friend  
Assign friend status/attribute to a user. If this user is already a friend you will see the option to remove 
him. 
 
Send Message 
Send a message to the selected user (chat). 
 
Show Shared Files 
Requests the list of shared files from a user. Users might have the option to show their shared list 
disabled. 
 
Upload Queue 
 
Show Details 
Show client details. 
 
Add friend / Remove friend  
Assign friend status/attribute to a user. If this user is already a friend you will see the option to remove 
him. 
 
Send Message 
Send a message to the selected user (chat). 
 
Show Shared Files 
Requests the list of shared files from a user. Users might have the option to show their shared list 
disabled. 
 
Unban 
Removes the ban made over a client. 
 
Filtering 
Enable the filtering option to show Credit or Friend clients listed only. 
 
Known Clients 
 
Show Details 
Show client details. 
 
Add friend / Remove friend 
Assign friend status/attribute to a user. If this user is already a friend you will see the option to remove 
him. 



 
Send Message 
Send a message to the selected user (chat). 
 
Show Shared Files 
Requests the list of shared files from a user. Users might have the option to show their shared list 
disabled. 
 
Unban 
Removes the ban made over a client. 
 
 

Search Window Context Menu 
 
Download 
Download the selected files. 
 
Download (Pause) 
Download the selected files, but set them on pause. 
 
Find related files 
Start a search (on the server your client is connected to) for related (companion) files to the file selected 
in the list. 
 
Remove Selected 
Remove the selected files from the search list. 
 
Clear All 
Remove all search tabs. 
 
ed2k Links 
Copy ed2k hashes or links to the clipboard in different formats (standard, HTML and with sources). 
 
Web Services 
A list of Web Services that can be customized by changing the file webservices.dat. You can use an 
special separation TAG to group options inside that file (<separator>). When used a line will be added in 
the selected position. 
 
 

Shared Files Window Context Menu 
 
Priority 
Set the file uploading priority. The file priority is the base value to compute the score for clients to 
advance in your queue and finally download from you. The base values are 2 for Very Low, 5 for Low, 
10 for Normal, 20 for high, and 50 for Release priority when the file is downloading or 100 when the 



file is complete. 
 
Permission 
Specifies shared file permission to show a file in the shared files list which can be requested by a remote 
user. This is a second level permission working after taking into account "Preferences->General->Files-
>See my share". 
- Hidden means that a file never will be added to the requested shared files list. 
- Friends only means that a file will be added only if a shared files list request is received from a friend. 
- Public means that a file always will be added to the requested shared files list. 
 
Shell Menu 
Opens a context menu with the Windows OS options for the file (e.g. delete, rename, etc.). 
 
Open containing folder 
Opens the folder containing the current file. 
 
Scan for viruses 
If you configured Antivirus support in the preferences, you will be able to launch specified software to 
scan selected files for viruses (only complete files are scanned). 
 
Edit file comment 
Set or change a comment/rating for a file. 
 
Reset all-time statistics 
Resets all stored PartTraffic statistics for a file. 
 
Reset session statistics 
Resets the PartTraffic session statistics for a file. 
 
Show all Known Files 
Show all Known files (the ones being shared and the ones not shared, but still known). This option 
changes the context menu and after that you can delete or merge them. 
 
Delete selected Known Files (Known Files list) 
Delete the selected known files. All file statistics and hashing information will be deleted. 
 
Merge Known Files (Known Files list) 
Merge statistics of differently named files with the same hashes. 
 
Show only Shared Files (Known Files list) 
Return to the Shared Files list. 
 
ed2k Links 
Copy ed2k hashes or links to the clipboard in different formats (standard, HTML and with sources) 
 



Web Services 
A list of Web Services that can be customized by changing the file webservices.dat. You can use an 
special separation TAG to group options inside that file (<separator>). When used a line will be added in 
the selected position. 
 
Enable (in the Chunk context menu) 
Allow uploading of the particular chunk. 
 
Hide (in the Chunk context menu) 
Disallow uploading of the particular chunk and don't report chunk availability to other clients. 
 
 

Messages Window Context Menu (Friends) 
 
Show Details 
Show client details. Only available when a client has been contacted in the current session. 
 
Add New Friend 
Add a new friend. You will need to give an IP and port so eMule Plus can contact the user. 
 
Remove friend 
Remove a user from the list of friends. 
 
Send Message 
Send a message to the selected user (chat). 
 
Show Shared Files 
Requests the list of shared files from a user. Users might have the option to show their shared list 
disabled. 
 
 

IRC Window context menu 
 
Join (on Channel List) 
Join a channel. 
 
Refresh (on Channel List) 
Refresh the channel list. 
 
Private Message 
Send a private message to the user. 
 
WhoIs, Slap, Owner, DeOwner, Op, DeOp, HalfOp, DeHalfOp, Voice, DeVoice, Protect, 
DeProtect, Kick 
These are normal IRC commands you can use in the eMule Plus client. 



 
 

Statistics 
 
Reset Statistics 
Clean all cumulative statistics. Data will be backed-up in case you want to recover old statistics values. 
 
Restore Statistics 
Reload old statistics values (before last reset) from the backup file. 
 
Expand Main Sections 
Expand only main sections of the statistics tree. 
 
Expand All Sections 
Expand all sections of the statistics tree. 
 
Collapse All Sections 
Collapse all sections of the statistics tree. 
 
Copy Selected Branch 
Copy all data from the selected branch to windows clipboard. 
 
Copy All Visible 
Copy all visible data to windows clipboard. 
 
Copy All Statistics 
Copy all data (visible or not) to windows clipboard. 
 
HTML Features 
It copies data in HTML format to windows clipboard. Export features generate HTML file with required 
images in the destination directory you selected. 
 
 

Rich Text Windows 
 
Copy 
Copy the selected text to the clipboard. 
 
Save Log to file (.log) 
Save the selected text to a file without any formatting. 
 
Save Log to file (.rtf) 
Save the selected text to a file with full formatting. 
 
Select All 



Select all window text. 
 
Clear 
Clear all window text. 
 
Autoscroll 
Enable/disable autoscroll (when the text reaches the bottom of the window, it is scrolled). 
 
Word Wrap 
A feature that causes words which extend past the right text window margin to be moved to the 
following line. 



Files Used 
 
Main Directory (where eMule.exe resides) 
 
/backup: backed-up files will be stored here unless you change the default path 
/config: configuration files (.dat, .ini and .met) are now stored in this directory 
/db: a directory for the Berkley database files used by eMule Plus 
/webserver: a directory containing all Web Server images 
 
countryflag.dll: library required for Country Flags feature 
unrar.dll: library required for Fake Check feature 
debug.log: a file with a log of all debug events (has to be enabled) 
download.log: a CSV file that stores all download sessions done by your client to be used for later 
analysis (has to be enabled) 
emule.log: a file with a comprehensive log of events (has to be enabled) 
upload.log: a CSV file that stores all upload sessions done by your client to be used for later analysis 
(has to be enabled) 
eMuleLight.tmpl: Web Server simple template 
eMuleXP.tmpl: eye candy template for Web Server (default) 
 
Config Directory 
 
clients.met.bak: backup of the clients.met file (in case of loss) 
ip-to-country.csv: IP to country database needed for the Flags & Countries feature 
ac_searchstrings.dat: stores auto-complete search history 
addresses.dat: a list of serverlists sites to update your servers 
cryptkey.dat: stores your secure identification (do not delete it or you will lose all your credits) 
fakes.dat: stores information about fake files 
gui.dat: stores GUI positioning for the transfer window 
ipfilter.dat: stores IP ranges to be filtered (no transfers from/to them) 
onlinesig.dat: the file needed by Online Signature programs having realtime statistics 
partperm.dat: stores permisions for chunks (srmb's PartStatus feature) 
preferences.dat: stores client information (do not delete it or you will lose all your credits) 
shareddir.dat: stores the list of shared directories 
staticservers.dat: a list of fixed servers (they won't be deleted) 
tempdir.dat: stores the list of additional temporary directories 
traffic.dat: stores upload statistics for Part Traffic feature (only for completed files) 
userhash.dat: stores the user hash (do not delete it or you will lose all your credits) 
webservices.dat: configuration file for WebServices (Fake Checks and other informative web sites) 
category.ini: stores categories information 
fileinfo.ini: stores comments about files entered by you 
preferences.ini: stores the main configuration and also the global statistics for your client 
statbkup.ini: keeps a backup of old statistics values after a reset (only the last one is kept) 
clients.met: stores the credits for other users that have uploaded data to you 



emfriends.met: the list of current friends 
known.met: stores the hashes, requested and transferred statistics for the files you have and you're 
downloading (not PartTraffic information) 
server.met: stores all servers you have in your list 
server_met.old: a backup of the last server list before an update 
autodl.ini: contains configuration of Auto Download feature 
 
Temporary Directory 
 
001.part: unfinished downloading file (part file) 
001.part.met: stores the filename, information about chunks and the file priority 
001.part.met.bak: a backup made from the 001.part.met file to help recovering the file in case of a crash 
001.part.met.bad: a copy of 001.part.met created by .part.met recovery engine (after some problem with 
001.part.met) 
001.part.dir: stores the alternative destination directory where complete file will be located (only if 
alternative destination was set) 
001.part.settings: stores the movie preview mode, stopped and preallocation status for each file 
001.part.txtsrc: stores the best sources found for each file to be used in future sessions 
001.part.stats: stores the statistics of the upload of chunks for files being downloaded 
 
upload.log file format 
 
Session uploads can be stored in a log file (CSV) with the present format: 
DATE, CLIENT_NAME, CLIENT_HASH, CLIENT_VERSION, FILENAME, 
TRANSFERRED_DATA, PART, DURATION, ISFRIEND, ISCOMMUNITY, ISONLAN, 
ISLOWID, STATUS 
example: 
22/12/2005 20:11:43,"client [ePlus]",0123456789ABCDEF0123456789ABCDEF,Plus v1.1g,"My 
Birthday Video.avi",11600300,2,536,Yes,No,No,No,successful 
 
download.log file format 
 
Session downloads can be stored in a log file (CSV) with the present format: 
DATE, CLIENT_NAME, CLIENT_HASH, CLIENT_VERSION, FILENAME, 
TRANSFERRED_DATA, PART, DURATION, CLIENT_ID, ISONLAN, STATUS 
example: 
22/12/2005 20:38:18,"client [ePlus]",0123456789ABCDEF0123456789ABCDEF,Plus v1.1g,"My 
Birthday Video.avi",108900,28,505,HighID,No,successful 
 
File naming has been changed in eMule Plus 1i. Please delete old file names not being stated here. 



Meaning of eMule Plus Icons 
 
eMule Connection Status 

 You're connected and with a high ID given by a server 

 You're connected but with a low ID given by a server 

 You're not connected to any server 
 
eMule Connection Status (system tray) 

 You're connected and with a high ID given by a server 

 You're connected but with a low ID given by a server 

 you're not connected to any server 
 
Server Status 

 Server is alive 

 Server failed response 

 You are connected to this server 

 this Server is static 
 
File Status 

 file is complete 

 file is completing 

 file is downloading 

 file is erroneous 

 file is being hashed 

 file is paused 

 file is stalled (there were no transfers for a week) 

 file is stopped 

 file is waiting 

 file is waiting to be hashed 
 
Sources Connection Status 

 Transferring or receiving hashset from client 

 On Queue or asking client 

 Connecting to client 

 No needed parts, asked for another file or unable to connect because of Low ID 

 Status unknown 
 
Client Software 



 eDonkey2000 (old v0.5x/0.6x) 

 eDonkey Hybrid Client 

 MLdonkey Client 

 xMule Client 

 Shareaza Client 

 aMule Client 

 eMule/eMule Plus Client (with SUI) 

 eMule/eMule Plus Client (without SUI) 

 lphant Client 

 unknown Client 
 
SUI: Secure User Identification 
 
Client Properties (could be different color regarding the client type) 

 Client with a high credit value 

 Client has a high credit value for your client (estimated) 

 Client has been banned 

 Client is a Friend 
 
Ratings 

 The average rating for this file is: Excelent 

 The average rating for this file is: Good 

 The average rating for this file is: Fair 

 The average rating for this file is: Poor 

 The file has been markes as a Fake 

 The file isn't rated but has a comment 

 The file isn't rated and doesn't have a comment (Shared Files list only) 
 
Friends 

 The friend is not connected 

 The friend is connected 

 The friend connected and linked 
 
Messages 

 You have an incoming message in the messages window 



JumpStart! 
 
This new option is specially designed for individual releasers on slow connections, as well as it helps to 
minimize releaser's upload traffic during distribution. 
 
It works as following: 
1. Individual releaser shares a file. 
2. Every client who wants to download that file is going to see only two chunks of that file for duration 
of JumpStart period. 
3. Each client sees two different chunks or if too many clients want that file, two least seen chunks. 
4. As soon as a chunk has been downloaded no one is going to see that chunk again for duration of 
JumpStart period (but you might have some clients in the queue for that already downloaded part). 
5. As soon as all chunks have been downloaded JumpStart period is over and everyone can see a full file. 
 
So, by the end of JumpStart period all chunks will be uploaded at least once and our tests (more than 30 
Jumps) show that in the most cases all chunks are uploaded at least once when total traffic for a released 
file is around 150-200% of the file size (e.g. all chunks for 600Mb file can be uploaded with 900Mb 
total traffic for that file). 
 
Things you have to know: 
1. Only for new releases! You cannot expect good results from JumpStart if a file is already spread. It 
might happen that some part is so well spread that no one will download it from you and in this case 
JumpStart will be waiting forever, you will be a 'No needed parts' source from other client's point of 
view. It is possible to turn JumpStart off any time you wish. 
2. For the same reason as #1 you cannot release from many sources (e.g. release groups). 
3. It works only for complete files. 
4. JumpStart stores data (e.g. already downloaded chunks) in the database so it's safe to restart eMule 
Plus. 
 
To activate JumpStart you have to go to Shared Files, JumpStart option is in the Priority context menu. 
Please note that file priority (e.g. Release) and JumpStart are two different things, JumpStart can be 
activated with any Priority. You can watch JumpStart messages in the debug log. 
 

The JumpStart FAQ 
 
My download speed sucks! Will this feature help? 
This feature is for releasers, to ease their burden of introducing new files to the network. This doesn't 
help you with your download speed problems. 
 
What is JumpStart? 
It is a system that greatly speeds up the initial spreading of file chunks for a new release. 
 
When can I use it? 
When you are starting a new release. In other words, when you are the only source and there isn't even a 



single byte of that file in the network yet. 
 
Well, I started releasing a file without JumpStart, can I turn it on now? 
No. It won't help the release at this time. But don't forget to do so on your next release. 
 
The file was already released, but a really long time ago, I'm sure there's nothing of it left on the 
network, so I'm turning JumpStart on anyway. 
Well, we can't really stop you... Just be prepared that JumpStart won't be able to turn itself off at the 
right time, and will perform worse than not using it. Specifically don't use JumpStart if you're answering 
a reshare request. 
 
I'm releasing the file simultaneously with my buddy, and you are saying I can't use this system? 
Correct. On a positive side, some of our tests have shown that sometimes you can do better with one 
machine using JumpStart than with two using a normal system. 
 
I'm downloading this file myself, and I want to help spreading it. Can I use this system for that? 
No, it does not work for incomplete files. 
 
Ok, I've completed the file, can I use it now? 
No, remember the golden rule, not a single byte of that file should be out there already. 
 
Wish I could try it.. But with my slow 12Kb/s upload I can't really release any files... 
Hey, we've got news for you! With this system we had people successfully releasing files on a 6Kb/s 
upload! 
 
If it works that well on those slow connections, then on my thick pipe it must be even better! I'll be 
able to release a file every 20 minutes! 
Umm.. The effect is much more noticeable on slow connections. On your fast one you probably won't 
see that big improvement, but anyway it will reduce upload traffic required for good file distribution. 
 
Something is wrong! People are complaining that they don't see a full source for a file! 
This is exactly how it works, the source (you) is there, but hidden. Explain it to those downloading from 
you. Even better to warn them when you advertise a file, that you are using a new system and it may 
*look* like there is no any full source. 
 
But what is the problem with the normal system? 
The problem is that you have no control over which parts of a file people are downloading from you, 
and some parts end up being uploaded many times, while others are not uploaded at all. The net result is 
that you can upload several times the size of the file and there still won't be a complete set of file parts 
spread on the net. 
 
So, how does it actually work? 
It works by showing only specific file parts to the clients, and by tracking precisely who has downloaded 
what. As soon as somebody has downloaded a complete chunk and can become a source for it, the 
system switches its attention to other chunks. 



 
What happens if somebody downloads a chunk and then disappears from the net? 
It's unpleasant, but it's not the end of the world. After the JumpStart period ends, the normal upload 
resumes and people would be able to pick the missing chunk from you. 
 
I'd like to reboot my computer, but I'm afraid. Will your system forget everything it had already 
done? 
No, the JumpStart state is kept between restarts. In fact we hope it is stored rather reliably. We're using a 
database now for this data-intensive feature. 
 
Where do you store the data? Is there a jumpstart.met file? 
No, we are using the Berkeley Database for this. The relevant files are located in the DB\ subdirectory of 
the main eMule Plus installation directory. 
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Servers Window 
 

 
 
1. Toolbar 
Common for all screens in eMulePlus, this handy row of buttons provides easy navigation between various screens and access to 
important features. You can change the skin, align the text labels and choose which buttons are visible by right clicking it.

 
●     1a. "Connect" Button

 
The leftmost button controls interaction with servers. It has three states. Initially the text shows 'Connect'. Click it and eMulePlus 
starts trying to connect to servers, and the text changes to 'Cancel'. Clicking the button now will stop the process of trying to 
connect. Once the connection to a server is established, the text changes to 'Disconnect'. Clicking the button now will disconnect 
the server to which your client is currently connected. 

●     1b. "Servers" Button
 
This is the page you start up in. It shows you the list of available servers and logs. 

●     1c. "Transfer" Button
 
Click this button to see lists and details of your downloads and uploads. 

●     1d. "Search" Button
 
Click this button to go to the search page where you can search for files to download. 

●     1e. "Shared Files" Button



 
Click this button to see the list of files you are sharing. 

●     1f. "Messages" Button
 
Click this button to go to the messages page. 

●     1g. "IRC" Button
 
Click this button to go to the IRC (Internet Relay Chat) page. 

●     1h. "Statistics" Button
 
Click this button to go see your detailed statistics and transfer and connection graphs. 

●     1i. "Preferences" Button
 
Click this button to open a new, multi-tabbed window where you can change the settings of your client. 

2. Serverlist Header 
On the left you can see the number of servers in your list. Click the New Server button to add a new server if you know its details. Click 
the 'Update server.met from URL' if you know a link where you can get a list of servers you want to try. 
 
3. Serverlist 
Shows the list of servers that your client is aware of. The columns show various details about each server, and clicking the column header 
will sort the list accordingly. The server you are currently connected to is highlighted in yellow. Double clicking a server will disconnect 
you from the current server and try to connect to that server. 
 
4. Server Context Menu 
Right clicking a server will bring up this menu. For a more detailed description of the various items in the menu, look up the topic 
"Context menus used in the GUI" in the FAQ. 
 
5. Log window 
This pane shows informative messages from three sources.

 
●     5a. Log

 
This is the general log which shows general status related information. 

●     5b. Serverinfo
 
Shows whatever information was provided by the server you tried to connect to. 

●     5c. Debug Log
 
Shows more advanced information which helps in finding and fixing problems with your client. In order to see this pane you have 
to enable it in preferences. 

6. Statusbar 
Like the toolbar, the statusbar is also visible in every page or screen. It provides a quick overview of important information. Hover your 
mouse over any part of the statusbar to bring up a tooltip with more information. From the left:

 
●     6a. Last Logline

 
This portion shows the last significant entry in the general log. 

●     6b. Session Runtime
 
This shows the time for which your client has been running. 

●     6c. Message Notification
 
When you receive a new message, an icon blinks in this area. 

●     6d. Users Count
 
The number beside the green humanlike icon shows the number of users currently on that server. 



●     6e. Upload Status
 
A blue up arrow shows that you are uploading data. It is grey when you are not uploading. The number shows upload speed. The 
number in brackets shows speed used by ed2k overhead (this is only visible if you enable it in preferences). 

●     6f. Download Status
 
A green down arrow shows that you are downloading data. It is grey when you are not downloading. The number shows download 
speed. The number in brackets shows speed used by ed2k overhead (this is only visible if you enable it in preferences). 

●     6g. Server Status
 
A globe encircled by a double-headed arrow indicates your connection status. A red arrow shows you are not connected. A green 
arrow shows you are connected with HighID. A yellow arrow shows you are connected with LowID. The servername appears 
alongside. 

 



Transfer Window 
 
It contains three main sections: Downloads, Uploads and Details. There is a little white triangle at the top left corner of each section on the 
header. Click this to collapse or expand the respective section if you need to more room for the other sections. You can also double click 
the header (the dark bar at the top of each section) to expand and collapse that section. 
 

 
 
1. Downloads Pane 
It lists the files you are downloading.

 
●     1a. Downloads Header

 
It shows a summary of the files in your Downloads section. Right clicking this header is a quick and easy way of clearing all 
completed files from your download list. Just below it is the Category bar, which is covered in item 2. 

●     1b. Column Headers
 
The caption describes the information that is listed for each file. Right click any header to get a context menu where you can select 
which columns will be visible. You can also sort the lists the way you want by clicking the particular column header. 

●     1c. File Type Icon
 
Click the file icon to the left of the filename (third icon from the left) to get a popup window with more information. For a more 
detailed description of the various icons, look up "Icons and their meaning" in the FAQ. 

●     1d. File Context Menu



 
Right click the file to get a context menu associated with the file. For a more detailed description of the various items in the menu, 
look up "Context menus used in the GUI" in the FAQ. 

●     1e. Source List
 
Each item in the list has a little [+] icon to the left of the filename. Click this to expand and collapse the list of sources found for 
that file. You can also use the + and - keys on the NumPad on your keyboard. Details of each source can be seen here and even 
more in tooltips, popups and context menus. To sort the sources instead of the files hold down the CTRL key while clicking the 
column headers. 

●     1f. List Context Menu
 
There is yet another context menu available if you right click in the empty space below the list. You can set global source filtering 
options using this menu. 

2. Category Bar 
Right click here to get a context menu to manage your categories. Choose from the preset categories, or create your own. You can 
customize each category with a different colour, priority, even temporary and incoming directories. To place a file in a particular category, 
use Assign to category from the context menu, or just drag and drop to the desired category tab. 
 
3. File Detail Tooltip 
This shows the large tooltip that is displayed when you hover your mouse over any file. Lots of useful information is summarised here for 
your convenience. Note the filename, which shows the number of the part file used for this file in the temporary folder. 
 
4. Uploads Pane 
It lists the clients that you are uploading to. As in the Downloads pane, you can hover, click and right click to get more information.

 
●     4a. Uploads Header

 
It shows a summary of the uploading information. Right click the Uploads header to change the view to list the clients in your 
upload queue. Right click again to see the list of connected clients. Right click yet again to return to the Uploads view. 

●     4b. Column Headers
 
The caption describes the information that is listed for each client. Click any header to get a context menu where you can select 
which columns will be visible. Also as in the Downloads pane, you can sort the lists by clicking the column headers. 

5. Details Pane 
It shows more detailed information about the file or client that you have selected in either the Downloads or the Uploads pane. The 
screenshot shows this pane in the collapsed state. Note the little white triangle on the header at the left. Click this to expand this pane, or 
just double click the header itself. 



Search Window 
 
It helps you to find and select links to add to your downloads. 
 

 
 
1. Main Search Box 
There are several fields in this box. There is the Name box where you can enter the text your filename must contain. As shown in the 
screenshot, the results will contain all the words entered here, in any order. You can also specify other parameters in the other boxes like 
minimum and maximum filesize, the type of file, extension, etc. to narrow down your search. Click the Start button to begin the search, or 
just press the Enter key on your keyboard. 
You can also choose the type of search that will be performed from the options in the Method drop down list. Your choices are server, 
global and FileDonkey. Be aware that server and global searches use up server credits, so use these sparingly or you’ll get blacklisted.

 
●     1a. "Clear" Button

 
It clears the text entered in the various boxes (except the Method box, of course) so you can start over. 

●     1b. Keyword History
 
The Name box also maintains a history of the searches you have made. If you start typing a word you have used previously, a drop 
down list with words starting with those characters appears, so if the word or phrase you want is in that list, you can simply select it 
instead of typing it again. You can clear this history of past searches by pressing CTRL+Del when the cursor is in the Name box. 

2. Search Result Tabs 



As is visible in the screenshot, you can access the results from several searches by just clicking the tab you want. Be aware though that all 
results are lost when the client is closed. 
 
3. Direct Download & Command Buttons 
This box is where you manually enter a link you have found somewhere. Click the Start button to add the link to your downloads, or just 
press the Enter key on your keyboard. You can also paste a link you have copied from somewhere, but it’s easier to just click the 
Download all ed2k links in clipboard button at the bottom left (see item 6a).

 
●     3a. "Start" Button

 
The Start button is also used to start the search based on the parameters entered in the search box (when the Direct Download box 
is empty). The button remains disabled (greyed out) while the search is in progress. In most cases during a global search, a progress 
bar appears at the bottom of the results pane to indicate that the search is being conducted. 

●     3b. "More" Button
 
If the number of results is very large, the results pane will only show about 150 items to limit the traffic and the More button to the 
right of the Start button will be enabled. To get more results, click the More button. This will give another batch of about 150 
results. Repeat if necessary, but try to focus the search better by changing the search parameters. 

●     3c. "Cancel" Button
 
The Cancel button can be used to cancel a search in progress as global searches can take several seconds to complete. 

●     3d. "Clear All" Button
 
The Clear All button clears the text you have entered in the Name box, as well as all the results obtained. 

4.Search Result List 
Double click the file you want to add to your downloads. Right click for more options. Pay special attention to the numbers in the Sources 
column. The first number shows the total number of sources found for the file. The second number in brackets shows how many of these 
sources have the complete file. There is little point in trying to download a file with no complete sources. 
 
5. Context Menu 
This is the context menu that appears when you right click a file in the results list. For a more detailed description of the various items in 
the menu, look up the topic "Context menus used in the GUI" in the FAQ. 
 
6. Download Buttons & Category Selection 
There are several buttons here. From the left:

 
●     6a. "Download all ed2k links in clipboard" Button

 
If you have copied a link from somewhere, click this button to add it to your downloads. 

●     6b. "Download Selected" Button
 
Clicking this button adds all the files you have selected in the search results to your downloads. Select multiple files by holding 
down the CTRL key on your keyboard, then click this button. 

●     6c. Category Selection
 
Here you have a button for each category specified in Downloads on the Transfer page. Pre-selecting a category (the Uncategorized 
button is selected by default) adds all subsequent downloads to that category (saves you having to manually move them later). 

 



Shared Files Window 
 
Information about the files you are currently sharing, or have shared in the past, is listed here. 
 

 
 
1. Button Area

 
●     1a. "Show all Known Files" Button

 
Normally only the files currently being shared are shown in the list. Click this button to show details of all the files that your client 
is aware of, including files that were shared earlier but have been removed from the share. Click this button again to show only 
currently shared files. 

●     1b. "Open Incoming Folder" Button
 
Click this button to open the folder specified in preferences as the folder for incoming files. Saves you the trouble of navigating to 
the folder manually. 

2. Shared Files List

 
●     2a. Column Headers

 
The caption describes the information that is listed for each file. Right click any header to get a context menu where you can select 



which columns will be visible. You can also sort the lists the way you want by clicking the particular column header. 
●     2b. Own Rating Icon

 
There is a little thermometer icon to the left of the filename (second from left). Click this to add a comment for the file, or edit a 
comment you made earlier. This comment will be visible to anyone who is in your queue for that file. The icon changes to a bug if 
you indicate that the file is corrupt or fake. 

●     2c. Part Traffic Details
 
Double click a file that has more than one part (filesize larger than 9.28MB) to expand the view to show details for individual parts. 
An asterisk "*" next to the part number indicates that it is complete. 

3. Context Menu 
This is the context menu shown when you right click an item in the list. For a more detailed description of the various items in the menu, 
look up the topic "Context menus used in the GUI" in the FAQ. 
 
4. Bottom Area 
There are two items here.

 
●     4a. Statistics Box

 
This shows a summary of transfer statistics for the selected file. Files that have never been requested can be considered for removal 
from the share if you have too many shared files. 

●     4b. "Reload" Button
 
Whenever you make changes to your shared files (add or remove files manually from the shared folders), you should press this 
button to update the list and send the information to the server you are connected to. 
Note: Servers don't like getting lots of data from clients, so use this button sparingly. 

 



Messages Window 
 
This is the Messages page. Here you can exchange messages with other clients. 
 

 
 
1. Friends Pane 
The usernames of all the clients that you have added to your list of friends are shown here. Right-click a username to get a menu for 
further action. 
 
2. Context Menu 
This is the context menu that appears when you right-click a username in the friends list. For a more detailed description of the various 
items in the menu, look up "Context menus used in the GUI" in the FAQ. 
 
3. Messages Pane 
Along the top of the pane are tabs for each chat session. Click the tab to see a history of the messages sent to and received from the client 
in question, along with the date and time stamp. 
 
4. Input Section 
Type or paste the text you wish to send into the text box and click the Send button. You can also press the Enter key on your keyboard. If 
successful, the sent message will be shown in the Messages pane, otherwise you’ll see a ***Connecting failed message. Sending messages 
to LowID clients will have limited success because such clients cannot be reached directly. 
Tip: to resend a failed message, press the Up arrow on your keyboard and click the Send button (or press the Enter key). 
The Close button closes the currently displayed session. 



IRC Window 
 
This is the IRC page. Here you can chat and exchange messages with other users. 
 

 
 
1. Nick List 
On the left part of the IRC screen you can see the current nicknames available on the selected channel. The top most nicknames are 
usually the managers of the channel, the operators and all others in power. Below that are the normal users. 
 
2. Context Menu 
This is the context menu shown when you right-click an item in the nickname list. 
 
3. Button Area

 
●     3a. "Connect" or "Disconnect" Button

 
●     3b. "Close" Button

 

4. Main Window

 
●     4a. Status Tab

 



This is the connection log to the IRC server, here you can see if the connection goes as planned, how far the connection has been 
completed, etc. 

●     4b. Channel List
 
When connected, the channel list will display all channels on the server, you will automatically join the channel set specified in 
Performsetting in preferences menu (#emule+ is default). 

●     4c. Message Tabs
 
Every channel you join will be a new tab. Some users contact other users personally, this will create a new tab with the user name. 
To leave a channel just close it using the red X icon. 

5. Input Area

 
●     5a. Text Box

 
When a channel or chat with another user is selected, messages can be filled out in the box below the chat screen. 

●     5b. Text Style Buttons
 
There are a few buttons here, one has a B, this is for boldtext, the U one is for underlinedtext, and the one with the paintdrop icon 
is for the font color you want to use. Colors can be fun to use but they can also be annoying, especially bright colors have this 
problem. When chatting you will see that there is almost no color being used in the channel. 

●     5c. "Send" Button
 
Click this button to send entered text. 

IRC Commands 
When the status tab is selected you can give IRC commands.

 
●     /nick name

 
This is a command to change your nickname (this can also be done on the IRC page in preferences). 
If a nickname is already in use you can see a line added in the status window, it tells that your nick is currently being used, some 
nicks are reserved, taking those will give a message too. 

●     /join #channelname
 
This is a command to join another channel. 

Some other IRC commands are available, but these are the most important and most used. 



Statistics Window 
 
This is the Statistics page. As the name suggests, all your statistics can be found here. 
 

 
 
1. Statistics Tree 
This pane holds the statistics tree which contains the bulk of the statistics in text form. Click the [+] icon at the left of each branch to 
expand it so that you can see its contents. Click the [–] icons to collapse the branches whose details you do not wish to be displayed. 
 
2. Statistics Tree Context Menu 
Right-click any item in the statistics tree to get this context menu with a list of commonly used functions. You can also get this menu by 
clicking the "Statistics" button at the top of the pane. For a more detailed description of the various items in the menu, look up "Context 
menus used in the GUI" in the FAQ. 
 
3. Download Speed Graph 
This pane shows your download speed in graphical form. The graph is scaled vertically as per the "Download Capacity" and horizontally 
as per the "Graphs Update Delay" in preferences. The legend above the graph indicates what the different colored lines represent. 
 
4. Upload Speed Graph 
This pane shows your upload speed in graphical form. The graph is scaled vertically as per the "Upload Capacity" and horizontally as per 
the "Graphs Update Delay" in preferences. The legend above the graph indicates what the different colored lines represent. 
 
5. General Connections Graph 
This pane shows general connections in graphical form. These are the connections between your client and other ed2k clients (peers). The 



graph is scaled vertically as per the "Active Connections Scale" and horizontally as per the "Graphs Update Delay" in preferences. The 
legend above the graph indicates what the different colored lines represent. 



Preferences Window 
 
This is the Preferences window. Practically all the configuration settings are set from here. There are a 
lot of settings so they are arranged in groups for convenience. 
 

 
 
1. Navigation Pane 
Click on a group tab (grey button) to see the tabs for that group. Click any tab in the selected group to 
see the preferences page for that tab. 
 
2. Detail Pane 
This is the area where the preferences for the selected tab are shown. There is a very detailed description 
for each preferences page in the FAQ under "Preferences Sections". 



System Tray Menu 
 
This is the menu that appears when you right-click the eMule icon in the system tray. 
(to get the icon in the system tray, see Preferences->General->Window) 
 

 
 
1. Download Speed 
This item has a slider which you can drag with your mouse to quickly set your download speed. You can 
also directly enter the figure in the little box at the right. If the slider and box are greyed out (disabled), it 
means that you have selected the option Limitless download (enable when download is >=10) in 
Preferences->Connection->Connection, so the download speed will be automatically calculated for you 
based on your upload speed. 
 
2. Upload Speed 
This item has a slider which you can drag with your mouse to quickly set your upload speed. You can 
also directly enter the figure in the little box at the right. 
 
3. Set both to Max 
Clicking this item sets your upload and download speed to the maximum based on the capacities you 
have set in ‘Transfer rates’ in Preferences->Connection->Connection. Quick and easy! 
 
4. Set both to Min 
Clicking this item sets your upload and download speed to the minimum. Upload speed is set to 1, 
download speed is set to 1 or 3 depending on whether you have selected the option Limitless download 
(enable when download is >=10) in Preferences->Connection->Connection. Very useful if you need 
more bandwidth for other things like surfing or direct downloading. 
 



5. Connect to any server 
Starts trying to connect to one of the servers in your server list. Warning: If you were already connected 
to a server, clicking this item disconnects you from that server and starts trying to connect to one of the 
others. 
 
6. Disconnect 
This item disconnects you from the server that you are connected to. 
 
7. Preferences 
Opens the Preferences window. 
 
8. Restore 
Opens the main client window (normal GUI). 
 
9. Exit 
Closes the client. If you have set Prompt on exit in Preferences->General->Window, you will be asked 
to confirm your choice, otherwise the client will close at once. 



Preferences 
 
General Section 
General 
Directories 
Files 
Sources 
Statistics 
Logs 
Window 
Window (Lists) 
 
Connection Section 
Connection 
Proxy Settings 
Server 
Web Server 
 
Messaging Section 
eMail Notifier 
IRC 
Messaging 
Notifications 
 
Advanced Section 
Advanced 
Auto Download 
Backup 
Part Traffic 
Scheduler 
Security 
Shortcuts 
Sorting 



General 
 
Nick 
You can set a nickname that users you upload to will recognize you by. Please change the default 
nickname for a proper one. A nickname can be changed at anytime without influence to your credits. 
 
Language 
You can choose desirable interface language. Translation is always a 'work in progress', so if you want 
to help then send us an email to eMulePlus@yahoo.com.sg 
 
3D Depth 
There are different ways of drawing the download/upload progress bars. From a rich 3D design to an 
aqua style while going through the standard flat style. You can choose between any of them. 
 
Beep on errors 
When an error such as insufficient disk space occurs the system beep sounds to alert you of the problem. 
 
Show Splashscreen 
Enable/disable the splash screen each time you start eMule Plus. 
 
Allow multiple instances of eMule 
With this option enabled you will have a choice to run multiple eMules on the same computer. Every 
instance has to be installed in a separate folder and be configured to use different TCP and UPD ports. 
Be aware that you cannot use the same temporary directory by multiple instances at the same time. 
 
Enable Online-Signature 
You will need this option enabled to publish your data in a signature. The file onlinesig.dat will be 
created and updated in the eMule Plus main directory. The data shown includes an online status, transfer 
speeds (download & upload), the server you are connected to and total number of users in queue. One of 
the programs (not the only one) that supports eMule Plus can be downloaded from http://onlinesig.
sourceforge.net/ 
 
Doubleclick on client display details 
Instead of initiating a chat session while double clicking a client you can open his details. 
 
Autotake ED2K links only during runtime 
With this option set ED2K links are only taken while eMule Plus is running. After application closure, 
the links are returned to the state before starting eMule Plus. This is useful to run multiple clients on the 
same computer. 
 
Watch clipboard for ED2K file links 
With this option set eMule Plus will monitor the Windows clipboard for ED2K links and add them as 
they appear. 
 

http://onlinesig.sourceforge.net/
http://onlinesig.sourceforge.net/


Update fake list at Startup 
Allows you to download an updated fake list every time you restart the client. 
 
Update 
Force the download of an updated fake list. 
 
from this URL (ed2kfakes.txt) 
The URL where the fakelist version information is located. This file contains the version number and an 
ed2k-filelink of fakes.rar which is added to your downloads and unpacked after completion 
automatically. 
 
Tooltip Delay Time (seconds) 
Tooltips with file/source/server information are show when the mouse cursor hovers over an object. This 
setting allows you to set time duration the cursor needs to hover before a tooltip appears. Set to zero to 
disable tooltips. 
 
ED2K Links 
Set your eMule Plus as the default application for ed2k:// links. This will take control from other 
applications such as eDonkey 2000 or OverNet. If you don't want this to happen then manually add links 
in the search window (Direct Download). 
 
Edit WebServices 
Opens webservices.dat file to edit WebServices. 
 
Main Process Priority 
Sets the process priority used by eMule Plus. A high priority setting will give a more responsive client 
but will use more CPU. Note: this high priority has less effect than OS process priority configured in 
Task Manager. 



Directories 
 
Incoming Files 
This is a directory where all completed files are stored. This directory is shared automatically and cannot 
be unshared (please don't add it to your shared directories). 
 
Temporary Files 
This is a directory where all incomplete files are stored. The incomplete files are shared once a full 
chunk is complete. Please don't add this directory to the shared ones. 
Note: changed settings will be used only after application restart. 
 
Video player for preview 
Full path to a video preview application. You can use your preferred application, but we recommend 
using VideoLAN client to get the best results. If nothing is specified, the default media player associated 
with corresponding file type will be used. 
 
Create backup to preview 
Downloading files can't be previewed by the most players. The backup file is intended to make a new 
file fixed to be previewed by this type of players every time you use the feature. You don't need this 
feature if you use VideoLAN client. 
 
Player supports small blocks 
With this option you will have preview enabled even for files with only small blocks completed (players 
like VideoLAN Client 0.6.2, aka VLC supports this). 
 
Shared directories 
You can select multiple directories to share on eMule Plus. Press the CTRL key while selecting a new 
one to add all subdirectories as well. 
 
Additional Temporary directories 
More temporary directories could be added to span temporary space over different disks. 
Note: changed settings will be used only after application restart. 



Files 
 
See my share 
Allows users to see your shared files list. Everybody means everyone can see. Friends means only 
users you have added as Friends. No one means nobody will see your shared files list. Allowing users to 
see your shared files list can be considered somewhat a 'security hole', and it’s been used for taking legal 
actions against p2p users in one country so far. 
 
Default Permission 
Default value of the file permission in the shared files list. 
 
Hashing Priority 
Every time a new file is shared eMule Plus hashes it and then publishes it to a server. This hashing can 
hog your computer for a while. By reducing the thread priority you can get a more responsive computer. 
 
Download Auto Priority 
When a download priority is selected as Auto these limits will be used to determine the priority 
automatically. After a number of the useful sources reaches the Priority High Limit, auto priority is 
changed to normal. After a number of the useful sources reaches the Priority Low Limit, auto priority is 
changed to low. 
 
Enable (Download Auto Priority) 
You can disable Download Auto Priority management by clicking this option. 
 
File Buffer Size 
Set how much data must be received before a flush to disk is made. A high setting might extend your 
hard disk life but also increase the risk of data loss in case of a crash. 
 
Copy Buffer Size 
Set a buffer used to transfer data while completing a file to another partition or a disk. The default 
setting is recommended for the most users. Take in account that increasing or decreasing of this value 
can have the file completion take longer than expected. 
 
Upload Autopriority 
Priority for Uploads will be automatically set when this option is used. For file you're downloading, with 
less than 25 sources a file will be prioritized as Release, with 25..199 sources will be prioritized as High, 
with 200..399 sources will be prioritized as Normal and with more as Low. For complete files, the 
calculation will be done against the full sources value for a file. With less than 5 full sources the file will 
be set as Release, with 5..24 as High, with 25..199 as Normal and with more as Low. 
 
Start downloads paused 
All newly added downloads will be started as paused. 
 
Start downloading paused file on complete 



Paused files will be started automatically after a download completes.  
 
Resume from other category when all done 
When all files were resumed from the current category where a file completes, files from other 
categories will be resumed. If you want to avoid this disable this option. 
 
Auto-clear completed files 
With this option enabled right after a file is completed it will be removed from the download list. 



Sources 
 
Adjust 'max sources per file' from (Auto 'max sources per file') 
The starting value for maximum sources allowed for each file, used on client start or server connection. 
 
to (Auto 'max sources per file') 
The maximum value of maximum sources a file can reach (top limit). 
 
Limit overall sources to (Auto 'max sources per file') 
The maximum global value of maximum sources allowed (for all files). After reaching this no more 
sources will be added to any file. 
 
Limit sources exchange to (Auto 'max sources per file') 
When Auto 'max sources per file' is used you can set the maximum value after which no more source 
requests will be sent. 
 
Enabled (Auto 'max sources per file') 
Enable the feature. 
 
Disable sources exchange 
Enabling of this option disables sending source exchange requests by your clients to remove users. 
Sources exchange brings more sources for your files, but also increases traffic overhead. Leave this 
option alone if eMule Plus is working properly. 
 
Disable for files with more than 
After a file reaches the number of sources entered in the input box, sources exchange won't be made 
anymore. Leave this option alone if eMule Plus is working properly. This feature is available only if 
Auto 'max sources per file' is disabled. 
 
Max Sources Per File 
Specifies the maximum number of sources allowed for a file. If this limit is reached, eMule Plus stops 
accepting sources for this file. Only enabled if Auto 'max sources per file' feature is disabled. 



Statistics 
 
Update Delay (Graphs) 
A time interval in seconds used to update the graphs for statistics display. Disable this by dragging the 
bar all the way to the left to save CPU resources. 
 
Time for average graph (Graphs) 
The time in minutes used to update the average graphs for statistics display. 
 
Active connections scale (Graphs) 
The maximum value of the y-axis for the connections scale graph. 
 
General connections scale ratio (Graph) 
The ratio modifier for the general connections as this number is always bigger in comparison with the 
average value. 
 
Update Delay (Statistic Tree) 
A time interval to update values of the statistics tree. 
 
Colors 
You can use your preferable colors for the graphs shown in the statistics window. 



Logs 
 
Write logs to disk 
emule.log file will be created in the main directory with all lines from the log added when this option is 
enabled. debug.log file correspondingly will contain debug log lines (if debug log is enabled). Beware 
that these files will grow in size. 
 
Enable Debug Log 
A more detailed level of logging can be achieved by enabling this option. The log will be placed on a 
separate tab in the server window. This feature is intended mainly for debugging or one-time curiosity. 
 
Enable Upload Sessions Log 
With this option enabled a detailed log is stored with a record of every upload session you made. Format 
is CSV and is explained in "Files used in eMule Plus and their purpose" section of this FAQ. 
 
Enable Download Sessions Log 
With this option enabled a detailed log is stored with a record of every download session you made. 
Format is CSV and is explained in "Files used in eMule Plus and their purpose" section of this FAQ. 
 
Enable debug log of auto 'max sources per file' 
Register the actions made by the feature Auto 'max sources per file' in the Debug log (should be also 
enabled). 
 
Enable Client transfer debug log 
Enables debug log messages related to client transfer activities. Debug log should be enabled. 
 
Do not log countermeasures (if enabled) 
Disable all kind of reports for leecher MODs detection/messaging. Debug log should be enabled. 



Window 
 
Start Minimized 
When selected eMule Plus starts minimized, and when combined with Minimize to tray icon it goes 
directly to the system tray. 
 
Minimize to system tray 
When selected eMule Plus goes to the system tray when minimized. 
 
Minimize to Tray on Close 
When selected eMule goes to the system tray on window closure. 
You will need to close eMule Plus from the system tray popup menu. 
 
Prompt on exit 
Whenever you close eMule Plus a dialog box requesting confirmation will be shown as a warning. 
 
Prompt on disconnect 
Whenever a manual disconnect is issued you will be warned and you will have the option to cancel this 
action. 
 
Prompt on friend deletion 
By disabling this option no warning will be given when you delete a friend from your friends list by 
pressing Del key. 
 
Bring to front on link click 
Whenever a download is added the eMule Plus window is shown on the screen. 
 
Show datarates on title 
Upload/Download datarates without overhead values are shown on the application title when this option 
is selected. 
 
Show Speed-meter on toolbar 
When selected a speed-meter is shown in the toolbar that shows the current download and upload speed. 
 
Font for IRC/Chat/Log 
You can set a font and a size used for IRC/Chat/Log texts. 



Window (Lists) 
 
Show file status icons 
Enables file status icons in the filename column of the download list. 
 
Show filetype icons on file lists 
Enables display of file type icons in the filename column of the lists. 
 
Show rating icons 
Enables display of the icons representing file rating/comments in the filename column of the download, 
search and shared files lists. 
 
Show country information on lists and tooltips 
Enables display of the country information for users and servers as well as country flags in the client 
lists. 
 
Show paused files in gray 
If selected file names will be shown in gray instead of faded out. 
 
Show A4AF filename on each source 
You can toggle between showing the string 'asked for another file' or the actual name of the other file 
requested from the source. 
 
Show A4AF sources count on Sources column 
Enables an additional value shown in the Sources column counting the number of A4AF sources 
available for that file. 
 
Show average datarate and smoothed remaining time 
When selected an average datarate (download speed) and a smoothed remaining time are added to the 
corresponding columns. These values appear in brackets. For complete files the average speed will 
remain showing the overall value of the current session. 
 
Show transferred data on Complete column 
Displays transferred bytes by each source in the Completed column instead of the Transferred column. 
 
Show downloaded percentage on progress bar 
When you set this option the percentage of completed file data is shown over a file progress bar. 
 
Round file and transfer sizes 
When enabled all file sizes and transferred values are rounded (201.20MB -> 201.2MB). 
 
Show Upload Progress on remote users 
Enables display of the remote users progress bars which represent file chunks statuses of the remote 
users. This is a useful feature for releasers to know the progress of the distribution. 
 



Always show sources having status 'On Queue' (Smart Filter) 
When Smart Filter for the download list is enabled, sources with 'On Queue' status will not be filtered. 
 
Hide sources with QR higher than (Smart Filter) 
When Smart Filter for the download list is enabled, sources with QR higher than the specified value will 
be hidden. 
 
Fake list download color (FakeCheck) 
Sets a color to be used in the download list for Fakes.rar download (this feature now uses ed2k network 
to distribute the files as the bandwidth usage was excessive for the database provider). 



Connection 
 
Profile 
A connection profile with all recommended settings for new users can be selected here. Most common 
Internet connection configurations are shown there. When a profile different from Custom is selected, 
the recommended settings can't be changed. 
 
Clientport 
eMule Plus uses 4662 as default port for data downloading from other clients. This port has to be 
accessed from outside, otherwise you will have lowID (firewalls and routers have to be properly 
configured). Some ISP throttle the speed on the default port, so it's better to change the default port 
value in this case. 
Note: changed value will be used only after application restart. 
 
Clientport UDP 
This port handles eMule's extended protocol like Client to Client Source Exchange and source asking on 
compatible eMule clients. Using inter client UDP reduces the connection overhead and also lessens load 
on servers. If the UDP fails then eMule Plus will drop back to TCP. 
Note: changed value will be used only after application restart. 
 
Clientport Disable 
With this option you can disable the UDP port. Clients will contact you via TCP rather than UDP once 
this option is disabled. 
 
Download (Capacities) 
Maximum capacity for downloads in KB/s. This value will be used for statistics plot scaling and for the 
system tray menu quick speed settings. This does not affect your download limit, but should be greater 
or equal to it. 
 
Upload (Capacities) 
Maximum capacity for upload in KB/s. This value will be used for statistics plot scaling and for the 
system tray menu quick speed settings. This does not affect your upload limit, but should be greater or 
equal to it. 
 
Download (Limits) 
Maximum downloads speed limit in KB/s. This setting must be chosen wisely as using the full line 
speed will degrade your downloads/uploads. A couple of KB/s below the data rate of your line will be 
ok. You won't download over this limit, even if you can. 
 
Upload (Limits) 
Maximum upload speed in KB/s. This setting must be chosen wisely as using the full line speed will 
degrade your downloads/uploads. A couple of KB/s below the data rate of your line will be ok. You 
won't upload over this limit, even if you can. 
 



Limitless Download (enabled when upload >= 10) 
This option disables download limit control -- maximal possible download speed will be used. That 
means that download speed will be limitless when upload limit is greater or equal to 10 KB/s (in this 
case 0 will be displayed in the download limit editbox), or it will be maximized according to the current 
upload limit (and corresponding ratio). The download limit slider in the system tray will be disabled in 
this case. 
 
Queue Size 
The maximum number of users allowed in your upload queue. A small number is preferred if you close 
eMule Plus regularly. A big number will be better if it is always on. 
 
Max. Connections 
The maximum allowed number of simultaneous connections. Having a large number (like 500) will 
improve your source finding and transfer speeds, but could hog your link. Windows 9x/ME can't handle 
more than 200 simultaneous connections; so going over it will render your system prone to crashes. 
Almost every home-router is limited to 256 simultaneous connections. In this case do not set the value 
higher than 200 to avoid problems. 
 
In 5 Sec (Max. Connections) 
The maximum allowed number of simultaneous connections to be started in a 5 seconds time frame. A 
setting of 20 is recommended for Win9x/ME users and Internet connections via router. 
 
Show overhead bandwidth 
The overhead generated by eMule Plus will be shown in the status bar and system tray tooltip when this 
option is enabled. 
 
Enable Lancast 
Lancast is a feature which enables eMule Plus to work better on a LAN. It makes eMule Plus broadcast 
(UDP multicast) its shares onto the LAN. Other Lancast enabled eMule clients will listen for these 
broadcasts and download files at a much faster speeds using their private IP addresses. Lancast doesn't 
break eMule Plus as a p2p application it just adds to it, promotes more sharing and saves upload and 
download bandwidth in LAN environments. Lancast transfer speeds are not limited by upload/download 
limits. 
 
Open client ports on internal WinXP firewall 
The setting activates automatic opening of the incoming UDP and incoming main TCP ports in 
Windows XP internal (built-in) firewall to enable unblocked communication for eMule Plus. All opened 
ports are closed at eMule Plus shutdown. 
This feature is intended to be used only for Windows XP internal firewall. 



Proxy Settings 
 
Proxy enabled 
Enables SOCKS or HTTP 1.1 proxy support. You need to have the required data about the proxy to use 
this feature. Take into account that a connection through a proxy is always a LowID one.  
 
Proxy type 
SOCKS 4/4a/5 and HTTP 1.1 proxies are supported. Choose the one you have. 
 
Proxy address 
IP address or DNS name of the proxy server. 
 
Proxy port 
Port of the proxy server. 
 
Username 
If the proxy requires validation set the needed username here. 
 
Password 
If the proxy requires validation set the needed password here. 
 
Authentication enabled 
Enables authentication support (SOCKS5 and HTTP 1.1 only). You must set a username and password. 



Server 
 
Server connection attempt timeout 
Sets server connection timeout after which a connection to the next server is initiated or a connection 
error is reported. 
 
Server connection Keep-Alive 
Sets time interval eMule Plus will use to send a message to a server to retain the connection when you 
have frequent disconnection problems. A value of 0 means disabled. 
 
Remove dead server after 
After the specified number of requests not being answered by the server, it is removed from the server 
list. 
 
Auto-update serverlist at startup 
When selected every time you start eMule Plus the server list will be downloaded from the web site 
specified in addresses.dat file. You can have multiple server list providers for backup in case one of 
them isn't working. It is recommended that you leave this option unchecked since most serverlists are 
being overloaded, and updating your serverlist is not necessary anymore -- the automatic serverlist 
updating mechanism through other clients and servers works extremely well. 
 
Use smart LowID check on connect 
If you receive a Low ID after a connection to a server eMule Plus will try to reconnect up to three times. 
After three attempts, automatic connection will be disabled. Server priority is being used to choose the 
connection order (High first, Low at the end of the connection queue). 
 
Update server list on server connection 
Request server list when you connect to a new server to update your local server list. If new servers are 
received, they are added to your local list. 
 
Update server list when a client connects 
Every time a source connects to you or vice versa, the server it is connected to is added to your server 
list if you don't have it yet. 
 
Restart waiting downloads on connect 
Every time a server connection is achieved eMule Plus will ask for sources for files paused or waiting 
for downloads. 
 
Autoconnect on Startup 
Every time you start eMule Plus it will try to connect to a server. Server priority is being used to choose 
the connection order (High first, Low at the end of the connection queue). 
 
Autoconnect to servers in static list only 
Connection to servers will be made to the servers on your static server list only when this option is 



selected. 
 
Reconnect on loss 
After a link or server connection drops, eMule Plus will initiate connection to a new server. Server 
priority is being used to choose the connection order (High first, Low at the end of the connection 
queue). 
 
Use auxiliary port to connect to a server 
Some servers support additional auxiliary ports for users that have the standard port filtered by their ISP. 
This port should be added manually to the server properties (there is an edit feature to do that) and will 
be used whenever it exists for the server your client is connecting and the feature is enabled. 
 
Use priority system 
Enable/Disable the usage of the server priority system. 
 
Set manually added servers to High Priority 
Priority of all manually added servers will be High. 
 
URLs for ICC 
A list of URLs (separated by '|') used to check the Internet connection when it's down so servers are not 
removed because of maximum connections failure. 



Web Server 
 
Port 
Web Server will listen this TCP port for HTTP requests. 
 
Template 
Allows you to select a different template. 
 
Password 
The password used to enable access to the service at login time. It's stored encrypted in the preferences.
ini file so you don't need to worry. 
 
Reload Templates 
By clicking this button the templates are reloaded without needing to restart the client. The templates file 
(eMuleXP.tmpl is the default but another one can be selected) can be used to tailor Web Server interface 
to your needs. 
 
Enabled 
Enable/Disable Web Server service. 
 
Password (Guest) 
The password used to allow Guest access to the service. It has only viewing rights. It's stored encrypted 
in the preferences.ini file so you don't need to worry. 
 
Enabled (Guest) 
Enable/Disable the Guest account access. 
 
Number of invalid login attempts (Intruder Detection) 
Sets the number of failed login attempts to be allowed before the login is disabled. You can set the 
number of minutes Web Server should be disabled for or even stop the service at all. 
 
Disable Login for (5-60) minutes (Intruder Detection) 
The number of minutes Web Server will be disabled for after an intruder attempt was detected. A value 
of 0 shutdowns Web Server (beware that you won't be able to login anymore until you enable Web 
Server service again). 
 
Enabled (Intruder Detection) 
Enable/Disable the Intruder Detection feature. 
 
Password (Mobile Mule) 
The password used to enable access to the service at login time. It's stored encrypted in the preferences.
ini file so you don't need to worry. 
 
Port (Mobile Mule) 
Mobile Mule server will listen this TCP port for requests. 



 
Enable (Mobile Mule) 
Enable/Disable Mobile Mule service. 
 
NOTES: 
To access Web Server you just have to enter this address in your web navigator’s address bar: http://
your_ip:port 
If you are behind a firewall you will need to open the specific port you selected. 
If eMule Plus is running on a machine connected to a local network, the IP that you need to type if you 
are trying to access Web Server from within the network is the local IP for that machine. 

http://your_ip:0/
http://your_ip:0/


eMail Notifier 
 
Server 
Full qualified name for the SMTP server used to send messages. 
 
Name 
Name to be used as the sender of the message. You will receive a message by this originator. 
 
From 
Originator e-mail address used for sending the messages to a user. 
 
To 
Destination e-mail address used for sending the messages to a user. 
 
Username (Authentication) 
Username used for plain authentication with the SMTP server. 
 
Password (Authentication) 
Password used for plain authentication with the SMTP server. This password is stored encrypted in the 
preferences.ini file. 
 
Enable (Authentication) 
Enable/Disable the use of authentication. 
 
Enable Information messages 
Information events will be notified by a message to a user whenever they take place (File completion, 
Received a new Message, etc). 
 
Enable Warning messages 
Warning events will be notified by a message to a user whenever they take place (Web Server intrusion, 
LowID, server disconnection, etc). 
 
Send message in subject 
The whole notification message will be sent in the subject field. 



IRC 
 
Server 
The hostname of the IRC server to use for the IRC feature. 
 
Nick 
The nick to be used for IRC only. 
 
Name (Channel List) 
Sets a name filter. 
 
Users (Channel List) 
Sets a minimum users filter. 
 
Use Channel List Filter (Channel List) 
Enables channel list filtering on server connect. 
 
Perform 
Sets a command to perform after a successful connection to an IRC server. 
 
Use perform string on connect 
Enable/Disable the perform command. 
 
Add timestamp to messages 
Every time a new message is received, it will be shown with corresponding time. 
 
Load server channel list on connect 
The list of channels will be requested every time you connect to the IRC server. 
 
Ignore info messages 
All channel information messages will be filtered out. 
 
Ignore eMule protocol messages 
All eMule protocol messages will be filtered out (ed2k link add, server link add, etc). 



Messaging 
 
Accept messages 
Chat messages can be enabled or disabled by this feature. You can also accept only messages from your 
friends list (Only from friends) and log all non-friends messages instead of discarding them (Put all non-
friends to log). 
 
Put me in away state 
Enable/Disable the away message feature. 
 
Away message 
You can enter a message to be sent to users contacting you when the Away feature is enabled. 
 
Filter messages containing 
Messages containing one of the strings added here will be filtered. To filter by more than one string use 
'|' separator between them (i.e. ban|queue|idiot). 
 
Filter comments containing 
File comments containing one of the strings added here will be filtered. To filter by more than one string 
use '|' separator between them (i.e. http://www.|release). 



Notifications 
 
Display time (Popup Properties) 
The duration of time the notification will be displayed. 
 
Font Size (Popup Properties) 
The font size used for the notification window. 
 
Use sound 
Enables sound for events notification (log and urgent events don't use sound notification). Select a file to 
be played every time an event occurs. 
 
New entry on log (Information messages) 
Whenever a new line is added to the log a notification takes place. 
 
A new chat session was started (Information messages) 
Whenever a chat session is initiated, you will receive a notification. 
 
A new chat message was received (Information messages) 
Whenever a chat message is received, you will have a notification about it. 
 
A download was added (Information messages) 
Every time a download is added, a notification will occur. 
 
A download was finished (Information messages) 
Every time a download is finished, a notification will occur. 
 
Scheduler Shift (Information messages) 
Every time a scheduler shift is executed, a notification will occur. 
 
Web Server intrusion (Warning messages) 
When an intrusion or an attempt is detected, a notification will take place. 
 
Out of disk space or erroneous file (Warning messages) 
Whenever you have not enough space to start new download or a file changes status to erroneous, a 
notification will take place. 
 
Server connection lost or got lowID (Warning messages) 
If you have a disconnection or/and after that you got a lowID then you will receive a notification. 



Advanced 
 
Client Request Threshold (Ban) 
The attempt number a request is made by the same client (without waiting for the minimum request 
time). After reaching this number of requests, a client is banned. 
 
times in (Ban - Client Request Threshold) 
The number of minutes after which a new request is accepted as a normal one. 
It can't be more than 9.83 minutes (the default eDonkey re-ask time is 10 minutes). 
 
Ban Time (Ban) 
The duration of the ban. After this length of time a user will be unbanned. Can't be more than 300 
minutes. 
 
Send message to banned users (Ban) 
A notification message ("You're being banned because your client is behaving aggressively!") is sent to 
each banned user. An entry is added to the debug log whenever a client is banned. 
 
Enabled (Ban) 
Enable/Disable Ban feature. 
 
Community Sharing 
Enter the name of the community you are member of. 
 
No Banning (Community Sharing) 
Community members won't be banned even if they behave aggressively. 
 
Enabled (Community Sharing) 
Enable/Disable Community Sharing feature. 
 
Max Sources Per File (Save/Load Sources) 
Number of sources to be stored between sessions. There is an upper limit of 20 and a lower limit of 5. 
 
Outdated after (Save/Load Sources) 
Sources will be removed after being for more than x days in the SLS file (x can be 1 or 2). Only active 
sources are stored every 10 minutes. 
 
Enabled (Save/Load Sources) 
Enable/Disable Save/Load Sources feature. 
 
Filename Cleanup 
What cleanup does: at first the filenames which may contain url-encoded characters like "%20" are 
decoded. Then space holders like underscore, "+" and invalid filename characters (\/:*?<>|) are replaced 
by spaces. After that special strings which can be defined using the Edit button and all unknown tags 
between [ and ] (if enabled) are removed. Dots are replaced by spaces only if they are not between two 



numbers like in version strings and dates. The first letter of each word is capitalized and the word "CD" 
is always written in uppercase. Advertising expressions like "Shared By" and "Sponsored For" are 
removed automatically and must not be defined in settings. Finally, space sequences are substituted by 
one space, and empty cleaned up brackets are removed. 
 
General warning on changing filenames: 
Images for CD recording software often consists of more than one file, e.g. *.cue/*.bin (CDRWin), *.
mds/*.mdf (Alcohol120%), *.ccd/*.img/*.sub (CloneCD), *.bwt/*.bwi/*.bws (BlindWrite). The option 
should be used with care when downloading such files. Changing the filename may result in error 
messages when trying to burn them as the correct filename is also saved within these files. If you change 
the filename, it has to be replaced in the according layout files, too. For *.cue files this can easily be 
done with Windows notepad, but the other formats mostly require some hex editor like UltraEdit or 
WinHex. For CloneCD it is only important that all files have the same (cleaned up) names. 
 
Auto-Cleanup filenames of new downloads (Filename Cleanup) 
Enables the feature for all new files added to the download list. 
 
Cleanup all between [ and ] (Filename Cleanup) 
Enables the feature for unknown tags even if they are not defined in settings. 
 
Edit (Filename Cleanup) 
Allows you to edit the strings being removed by the cleanup feature, separated by pipes. There is a 
predefined set of the common strings. 
 
Enable countermeasures against unfair clients 
Many clients have some unfair options that harm legit eMule users (i.e. less slots available, no upload, 
hash stealing and more). By enabling this option eMule Plus will try to overcome this wrong behaviour. 
Leecher MODs are banned after detection and a message will be kept in the debug log if 'Send message 
to banned users' option is disabled. 
 
Auto-check for new eMule Plus version 
With this option you will be informed (in the log) on client startup that a new version is available. 



Auto Download 
 
Enabled 
This feature can be enabled or disabled here. 
 
URLs configuration 
The list shows all Auto Download URLs and their configured check intervals in minutes. 
 
URL check interval (minutes) 
Enter the desired interval and click on the Apply button to change the interval for the currently selected 
URL. 
 
New URL 
Adds a new URL to the list. Click an address in the list to select it; click it again to edit it (just like 
renaming a file with Explorer). 
 
Erase 
Removes the currently selected URL from the list. 



Backup 
 
*.dat, *.met, *.ini, *.part, *.part.met, *.part.txtsrc 
Select file types to be backed up. Beware of *.part files as they're mostly big (because of their size, 
backing up *.part files may take a few minutes). 
 
Select all 
Selects all file types to be backed up. 
 
Backup now 
Performs manual backup. 
 
Auto Backup on Exit (Overwrite) 
Files will be backed up each time you close eMule Plus. This option always overwrites already existing 
files. 
 
Overwrite existing files 
Whenever a backup is done files will be overwritten. 
 
Backup selected files every [ ] hrs 
A scheduled backup can be set with this option to be run every defined number of hours. 
 
Backup directory 
This is a directory where all backed up files will be stored. 



Part Traffic 
 
Display Part Traffic 
Part traffic feature can be enabled or disable to help low-end computers. 
 
Upload bar style 
Changes the style of the bar shown in Shared Files. All required data is stored even if you use the 
minimum configuration, so you can switch back to the most informative style later. 
 
Upload bar color 
Sets the color style for the upload bar. 
 
For more information go to FAQ->Common questions and their answers. 



Scheduler 
 
With this feature you can set different datarates for different time frames. This is useful when you need 
almost the whole bandwidth available for work duties during day, but you can allocate the whole 
bandwidth for sharing at night. 
 
Enable 
Enable/Disable this feature. 
 
Time 
The time when the datarate shift will take place. Datarates will be changed only at this time, and settings 
are not verified until the configured time arrives to save CPU cycles. 
 
Download 
Desired download speed to be used after the configured time. 
 
Upload 
Desired upload speed to be used after the configured time. 
 
Max. Connections 
Desired maximum connections to be used after the configured time. 
 
In 5 sec 
Desired maximum connections in 5 seconds to be used after the configured time. 
 
Except 
Any day of the week can be excluded not to change datarates on this day. That means the last datarate 
change that will take effect will be the one of the Shift 1 (i.e. if you set a Saturday exclusion the Friday 
Shift 1 will be the last used). 



Security 
 
Filter Level (0-255) (IP Filters) 
Sets the number that will serve as the filter value for the feature. Any lower value will be filtered, but 
beware that you can start to lose valid sources if you set a wrong value here. 
 
Filter Clients (IP Filters) 
Clients listed in the ipfilter.dat database will be filtered and no connection will be established nor a 
response to any request will be sent to them. 
 
Filter servers (and DynIp servers) 
IP addresses listed on the ipfilter.dat file will be filtered from the server list and their connections 
refused. Dynamic IP servers will be filtered as well. 
 
Update at startup (IP Filters) 
Forces database update at startup. You can set the period of the updates, please try to be conservative not 
to exhaust database providers allowed bandwidth. 
 
from this URL (IPFilter or PeerGuardian format) (IP Filters) 
Sets the URL from where the database will be downloaded. 
 
Update (IP Filters) 
Forces the update and real-time reload of the database. After successful operation, update won't be 
allowed to be done again for 24 hours to protect database providers and avoid misusage of the feature. 
 
Filter clients doing File Scanning for 24hs 
Some aggressive clients request files you don't have or even never had (this is a common MLdonkey 
behaviour). With this option you can filter them as a penalty for their misbehaviour. 
 
Filter clients sending small fake data packets 
There are fake ed2k clients sending small uncompressed packets with incorrect data. Enabling this 
setting will discard such packets avoiding data corruption and filter out such users. As such cases are 
very rare, please, use this option only when you get such kind of packets. 
 
Automatically scan completed downloads (Antivirus) 
Whenever a file completes, an Antivirus scanning by the specified tool will be started over it. 
 
Antivirus Program (Antivirus) 
Specifies full file name of the executable file used by your Antivirus software to scan files. 
 
Scan Parameters (Antivirus) 
Sets the parameters needed (if any) to do the scan over the file. 
 
Enabled (Antivirus) 
Enable/Disable this feature. 



Shortcuts 
 
Keyboard combinations can be added to standard eMule Plus actions. Select an action and then enable 
the feature and choose the shortcut to be used. 
 
Enable shortcut 
Enables a shortcut for the selected action. 
 
Alt/Shift/Ctrl/Win (keys) 
Select any combination of control keys to be used with a normal key for the shortcut. 



Sorting 
 
Show paused and stopped files last 
The download list sorting will place paused and stopped files at the end of the list with this option 
enabled. 
 
Use these settings 
Sorting preferences will be loaded on every start and maintained when this option is enabled. 
 
Sort [...] by 
Sort order for [...] (named list). 
 
Sort Clients by (When Expanding Sources list) 
First sorting order to be used for expanded file sources list. 
 
and by (When Expanding Sources list) 
Second sorting order to be used for expanded file sources list. 



Some useful tips for your eMule Plus experience 
 
Right-click on the Download header to clear all completed files. 
 
Click on the status icon of the complete file clears only this file. 
 
Right-click on the Upload/Queue/Known Clients header to switch the view between Upload, Queue and 
Known Clients lists. 
 
Clicking over a notification text will bring the referred window to the front. 
 
Pressing CTRL while adding a directory to share (Preferences->General->Directories) will add all 
subdirectories as well. 
 
Right-click on the toolbar to customize it or change the style (Double-click on the toolbar to customize 
it). 
 
SHIFT-Drag can be used to move/delete toolbar buttons for faster customization. 
 
You can search with FileDonkey extension search (Web search). Just select the method used for the 
search and use the available search parameters. 
 
Get First/Last chunks for movie preview has been simplified to select the best mode automatically and 
as always is selectable for each file. It also supports OGM/MKV previewing as well with any part 
enabled player (VideoLAN client, ZoomPlayer, Media Player Classic, etc). 
 
A different preferences.ini is created with each new version of eMule Plus (format: preferences[version].
ini). Old files for versions not used anymore can be safely deleted if you don't need or want them. 
 
With the cleanup feature on the context menu of the download list you can choose to cleanup one or 
more selected files through it instead of using the file detail dialog on every file. 
 
Use the Ctrl key over the download list while clicking column headers to sort sources. 
 
To remove search history you can press CTRL+DEL when positioned in that edit box. 
 
Renaming of already downloaded file without rehashing -- right-click on the file in the Shared Files list, 
Shell Menu -> Rename. 
 
You can search in the lists using Ctrl-F/F3/Shift-F3 to start search/search next/search previous 
correspondingly. 
 
Up/down arrows in the chat message editbox can be used to access the previously entered messages. 
 
To reduce the system load caused by file completion keep file temporary and destination directories on 
the same partition. 



 
Fast comments editing -- click on the file rating icon in Shared Files list to edit your comment or change 
rating. 
 
Some list columns contained two values have alternative sorting possibility, to sort by the second 
column value click column header several times (double arrow will appear on the column header). 
 
Shift + double-click on a file in the Shared Files list expands file parts, but it will only show parts ever 
uploaded. 
 
Ctrl-Shift + double-click on a file in the Shared Files list expands file parts, but it will only show parts 
uploaded in the current session. 
 
Use Shift key while clicking column headers in the shared files list to sort also parts information. 
 
To search for a file on servers using file hash, enter ed2k::<hash> or a complete ed2k link into Name 
edit box. 
 
 
Command-line Interface (cli) 
 
You can issue command-line operations by running 'emule.exe command'. 
Current valid commands are: 
 
connect: connect to any server 
disconnect: disconnect from current server 
resume: resume a paused download 
exit: exit client (if you have the option to ask on exit you will be asked) 
reload: reload Shared Files (hash newly added files) 
restore: maximize eMule Plus window 
limits: set upload and download limits. Command format limits=[UpLim][:DownLim]. Ex: 
'limits=10:64', 'limits=10', 'limits=:12.5' 
status: gives a status report about downloads 
 
 
upload.log file format 
 
Session uploads can be stored in a log file (CSV) with the present format: 
DATE, CLIENT, CLIENT_VERSION, FILENAME, TRANSFERRED_DATA, PART, TIME, 
ISFRIEND, ISCOMMUNITY, ISONLAN, STATUS 
example: 
01/04/2004 20:11:43,"client [ePlus]",Plus v1k,"My Birthday Video.avi",11600300,2,536,Yes,No,No,
successful 



Servers Window context menu 
 

 ED2K link 
Copy an ED2K server type link to the clipboard. 
 

 Connect 
Connect to the server that is currently selected. 
 

 Remove Selected Server 
Remove server from server list. 
 

 Add to Static Server List 
Add the current selected server to the static list to be fixed in each session you start. You can set an 
option to connect to this kind of servers only. 
 
 

Transfer Window Context Menu 
 

 Filedetails 
A complete list of file details is shown. 
 

 ED2K Links 
Copy ED2K links to the clipboard. 
 

 Clear Completed 
Clears a file that is completed (green progress bar). This only appears when a file is completed. 
 

 Download From All A4AF Sources 
Force all 'Asked for Another file' sources to switch to this file. This means more sources will be queued 
for this file. 
 

 Download From All A4AF Sources (Auto) 
Automatically take all 'Asked for Another file' sources so the file can be completed faster. 
 

 Stop 
Stops a selected file. All found sources will be lost and after resuming the client they will have to find 
them again. 
 

 Pause 
Pauses a selected file. All found sources will be retained and after resuming will be contacted again. 
 

 Resume 
Resume downloading of a stopped or paused file. This only appears when a file is stopped/paused. 



 
 Cancel 

Cancels and deletes a selected file from the download list. This can't be undone, so be careful. 
 

 Rename 
Renames a selected file. 
 
 

Transfer Window Queue Context Menu 
 

 Friend 
Set or unset user as a Friend. 
 
 

Shared Files Window Context Menu 
 

 ED2K Links 
Copy ED2K links to the clipboard with different formats (with source when you're connected). 
 

 JumpStart 
Enable the Jumpstart feature for this file. 
 
 

Search Window Context Menu 
 

 ED2K link 
Execute (eMule/eMuleXP templates) or copy (eMuleLight template) ED2K link to the clipboard. 
 
Tip 
Since 1h there are menus for setting file priority, category and other things as well like columns shown. 
A popup menu with different options will appear whenever you hover over a text or image with this 
feature enabled. 
 
 

Meaning of WebServer Icons 
 
Server Window 

 You're connecting to a server 

 You're connected and with a high ID given by a server 

 You're connected but with a low ID given by a server 

 You're not connected to any server 
 
Server Properties 



 The marked Server is in your static server list 
 
Shared Files Window 

 You're just downloading this file 

 This file is complete 
 
Shared Files Properties 

 The marked file priority is release 

 The marked file uses JumpStart 
 
File Status (Download Window) 

 file is complete 

 file is completing 

 file is downloading 

 file is erroneous 

 file is being hashed 

 file is paused 

 file is stalled (there were no transfers for a week) 

 file is stopped 

 file is waiting 

 file is waiting to be hashed 
 
File Properties (Download Window) 

 You've enabled auto-A4AF for this file 
 
Client Software 

 eDonkey2000 (old v0.5x/0.6x) 

 eDonkey Hybrid Client 

 MLdonkey Client 

 xMule Client 

 Shareaza Client 

 aMule Client 

 eMule/eMule Plus Client (with SUI) 

 eMule/eMule Plus Client (without SUI) 

 lphant Client 

 unknown Client 
 
SUI: Secure User Identification 



 
Client Properties 

 Client with a high credit value 

 Client has been banned 

 Client is a Friend 



DBGHELP.DLL update from Microsoft 
 
This updated file is only needed to create dump files for debugging eMule Plus' crashes. 
The dump files will be used by developers to investigate where the problem was at the time of the crash. 
Files must be sent to: eMulePlus@yahoo.com.sg. Please mention which version you were using in the 
subject/body of the email as well as related details. 
 
Please download the file needed, decompress it and put DBGHELP.DLL file into eMule Plus directory: 
 
Windows 98/Me/NT4/2000/XP: DBGHELP.DLL version 6.2.13.1 
 
 

Helping us help yourself 
 
When you report a bug we need all information you can provide -- when it happened, last actions, etc. It 
isn't useful you say it crashes, we need data about what was happening before that. In problematic cases 
we recommend to enable debug logging: when eMule Plus is closed edit the file preferences.ini and set 
the following values: 
 
"preferences.ini"

[eMule] 
Verbose=1 
LogToFile=1 
BugReport=1 
CMNotLog=1

 
The same settings can be configured in Preferences->General->Logs -- enable 'Write logs to disk', 
'Enable Debug Log' and disable 'Do not log countermeasures' (restart isn't required in this case). 
 
Start eMule Plus and when it happens again, open debug.log and look for errors and "exceptions". You 
can paste the log in the support request thread, but observe the forum rules about content and users IPs 
(must be removed). 
 
 

My Windows 2000/XP/2003 just silently reboots 
 
You're probably getting a Blue Screen of Death (BSOD), but Windows is setup to reset your machine 
when it happens. To disable this feature and get some useful information on which driver is causing a 
crash you need to disable automatic rebooting:

mailto:eMulePlus@yahoo.com.sg
http://emuleplus.sourceforge.net/files/dbghelp6.2.13.1.zip


 
●     Right-click My Computer, and then click Properties.

 
●     Click the Advanced tab.

 
●     Under Startup and Recovery, click Settings to open the Startup and Recovery dialog box.

 
●     Clear the Automatically restart check box, and click OK the necessary number of times.

 
●     Restart your computer for the settings to take effect.

 

Post the BSOD error in Support forum, these errors are usually caused by driver problems or hardware 
failures. 
 
 

Common problems and solutions 
 
* Error message on start: DbEnv::open:DB_runrecovery:fatal error, run database recovery 
Database files are probably corrupted. Close eMule Plus, delete DB directory located inside eMule Plus 
main directory and run eMule Plus again -- database will be reset. Side effect -- all JumpStart statistics 
will be lost. 
 
* Application cannot start: eMule.exe process is running utilizing 99% of the CPU, but application 
window doesn't appear. 
Database files are probably corrupted. Kill eMule.exe process, delete DB directory located inside eMule 
Plus main directory and run eMule Plus again -- database will be reset. Side effect -- all JumpStart 
statistics will be lost. 
 
* Can't restore from the system tray or system tray icon disappeared: execute emule.exe restore 
command in eMule Plus directory or type <path>emule.exe restore in the 'Run' box in Windows, where 
<path> is a full path to emule.exe on your drive. 
 
 

Other workarounds 
 
When you see yourself multiple times in the queue it's probable that you have yourself in the stored 
source. Remove the .txtsrc files from the temporary directory to solve this problem. 
 
If you have a crash on start you might want to delete known.met because it could be corrupted or the 
format might be not compatible with this new version. Note: this action will result in rehashing of all 
shared files. 
 
If you have random GUI crashes try to update your video driver to the last stable one provided by the 
manufacturer. 



 
If nothing works start from scratch (with a new installation). Keep the following files: addresses.dat, 
ipfilter.dat, preferences.dat, shareddir.dat, staticservers.dat, tempdir.dat, userhash.dat, webservices.dat, 
clients.met and emfriends.met as well as the Web Server template and images directory. You will have to 
rebuild all configuration and rehash all files again right after start, but you will keep credits and your 
friends. 
 
If you can connect to your Web Server and you got a message after login: You have chosen to download 
a file from this location: "/ from abb1b021[1]" then you should set in IE (Tools/Internet Options/
Advanced) the "use HTTP 1.1 through proxy connection" to enable. 
 
If you want HTTPS secured connection, try to use Delegate (find more info at http://www.delegate.org/
delegate/ssl/). This tools is a freeware open-source project as well. 
 
If you have too many 0.x upload slots with the zz upload system try to reduce the upload limit a bit and 
wait 30 minutes until it stabilizes. Reaching your maximum bandwidth isn't any good for the way the 
system calculates the needed slots, so please make your limit lower than the line maximum. 
 
If your Online Signature is not working as intended, set your application title to 'eMule Plus v' (DRA:
GOD app: in onlinesig options, general, bottom right corner there is a textbox, set that value there). 
There are other programs supporting custom application strings, take a look at their sites: winki2099 
(site in German), Dawui (site in Spanish) and also get the most updated versions of DRA:GOD 
supporting application name. 
 
If you get the error Could not check latest fakelist version and cannot browse the donkeyfakes homepage 
directly then try to browse the donkeyfakes homepage proxied over the free anonymizer. When this is 
working for you now, just put the following address (including last slash) in front of the URL to 
ed2kfakes.txt in preferences dialog and in front of the URL to eDonkey-fakes in webservices.dat file : 

http://anon.free.anonymizer.com/

 

http://www.delegate.org/delegate/ssl/
http://www.delegate.org/delegate/ssl/
http://onsig.winkie.de/
http://www.emulespana.net/forums/viewtopic.php?t=5689
http://onlinesig.sourceforge.net/
http://donkeyfakes.gambri.net/
http://anon.free.anonymizer.com/http://donkeyfakes.gambri.net/
http://www.anonymizer.com/
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